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1 Preface

A Geographic Information System (GIS) can be a useful tool for preparing the input of models and
tools. Furthermore, in this era of Open Data ample open access data is available that can easily be
retrieved from the internet and integrated in open source desktop GIS software, such as QGIS.

These exercises will guide you through different steps that are needed to preprocess data to be used
in models and tools. In the first exercise you will learn how to register a scanned topographic map
and use it as a backdrop for digitizing vector data. In the second exercise you will learn how to import
data from spreadsheets into a GIS and to use it to join tables, manipulate the attribute table and
interpolating the data to a continuous raster layer. In the third exercise you will download open
access data from OpenStreetMap and use it for further analysis and conversion. The geodatabase will
also be introduced in this exercise. In the fourth exercise you will use map algebra for spatial
planning. Finally, you will learn how to delineate catchments and streams form digital elevation
models and to present them in maps or in an interactive webpage.

The exercises have been developed for different MSc programmes at IHE Delft and tailor made
trainings in Uganda, financed by the Vitens Evides International (VEI) fund. | would like to thank Jan
Hoogendoorn and Jonne Kleijer, GIS experts from VEI, for their contribution to these exercises. The
Adjumani dataset was developed by VEI and the National Water and Sewerage Corporation (NWSC)
in Uganda. I’'m thankful for their permission to use the dataset for educational purposes.

In the near future we will further update the exercises and distribute it as Open CourseWare so the
whole community can use the course materials.



2 Introduction

2.1 Learning objectives
After following this step-by-step tutorial you will be able to:

e Use QGIS in its main functionalities, also in conjunction with plugins
e Digitize features from a scanned map or satellite image

e Import tabular datain a GIS

e Do simple vector analysis

e Interpolate point data

e Convert vector and raster data

e Reproject vector and raster data

e Use map algebra

e Useonline data

e Perform catchment and stream delineation

2.2 Software requirements
During the next exercises we will make use of the following software:

e QGIS ver 3.4 (Madeira) or higher,
e Google Earth,

o Firefox Mozilla

e MS Excel or OpenOffice Calc

You need an internet connection to download plugins or to use the open access data.

2.3 Preparation
Please note that QGIS is already installed on the laptops of IHE Delft participants. Please do not
change the version and skip this section. The exercises have been tested for QGIS 3.4.

1) Download QGIS from http://www.ggis.org/en/site/forusers/download.html
2) Install QGIS
3) Install the exercise data from http://ocw.unesco-ihe.org

2.4 Convention
Throughout this guide we have used three different fonts according to what kind of operation we
wanted to point at:

— Calibri, is used for the main text
— Times New Roman, Italic, is used to identify software commands

— Courier New is used for text input, that is text that you have
to write in the software, or for file names


http://www.qgis.org/en/site/forusers/download.html

3 Getting familiar with QGIS

3.1 StartQGIS3
You can start QGIS 3 Desktop by looking for it in the Start menu or using the search function. Make
sure you open the QGIS Desktop with Grass in order to have all functionality we need.
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3.2 The screen
Like many commercial GIS also QGIS has a "traditional" GIS layout.

It is made of the Standard System Menu or Main Menu (we will refer to Main Menu in the following
pages) which is always on the top of the software's window, of standard toolbars like the Zoom
Tools, or others that can be activated clicking in the Main Menu View and then Toolbars.

On the left hand side there is the Table of Content (Layers list) area, where all the layers displayed

are shown. To the left of this space there is a vertical toolbar, the Manage Layers toolbar.
In the centre of the window is the Map Canvas, where all maps will be displayed.

More information about the QGIS Graphical User Interface can be found here:
http://docs.qgis.org/2.18/en/docs/user _manual/introduction/ggis _gui.html



http://docs.qgis.org/2.14/en/docs/user_manual/introduction/qgis_gui.html
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Exercise 1: Digitizing from a scanned
map




4 Digitizing from a scanned map

4.1 Introduction
In order to use hardcopy maps in a GIS, they need to be scanned and georeferenced. Georeferencing
is also needed for raw remote sensing images, such as aerial photographs and satellite images.

For the best result, choose a map sheet that is clean and does not have too many folds. Use a
scanner that is large enough to scan the whole map. The resolution of the scanner should be large
enough (e.g. 1200 dpi) to have enough detail in the resulting raster maps.

For georeferencing we need to link locations on the scanned image to coordinates. There are two
ways:

1. Collect ground control points (GCPs) at locations that are clearly visible in the image, such as
bridges and junctions.

2. If the hardcopy map contains a coordinate grid, you can use the printed grid as a reference.
Make sure that you know the projection of this grid, which usually is stated on the map.

In this exercise we will use a scanned map of Mount Marcy (USGS, 1979)

(Mount Marcy New York USGS topo map 1979.JPG), which we will georeference with
the coordinate grid printed on the map. You can find the data (Data Exercise 1) on the
OpenCourseWare website (http://ocw.unesco-ihe.org/course/view.php?id=11). Save the map on

your hard drive (e.g.
D:\QGIS Exercises\Exercise 1\Mount Marcy New York USGS topo map 1979
.JPG

4.2 Choosing the projection

Have a look at the scanned map and try to find the projection that has been used. You can use any
image viewing software for this. Which projection was used? Look for the EPSG code in
http://www.spatialreference.org and write it down.

4.3 Enable the Georeferencer GDAL plugin
The Georeferencer GDAL plugin is a core plugin, which means that it is already installed. In order to
use it, you need to activate it. This works as follows:

1. Inthe main menu go to Plugins - Manage and install plugins...
2. Search for Georeferencer GDAL and check the box
3. Click Close to close the dialogue


http://ocw.unesco-ihe.org/course/view.php?id=11
http://www.spatialreference.org/
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| & geor L <]
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‘ Mot installed # ImportPhotos Georeferencer GDAL
& QWeather H H
b Upgradeable el Georeferencing rasters using GDAL

i: New

%% Install from ZIP

Invalid

# Video Uav Tracker
Category Raster
Installed version Version 3.1.2

J] | o]

ﬁ Settings Upgrade All Uninstall Plugin | Reinstall plugin |

Close | Help |

4.4 Importing the scanned map into the Georeference GDAL plugin
1. From the main menu choose Raster > Georeferencer ...

2. Click the Open Raster button
Browse to the Mount Marcy New York USGS topo map 1979.JPG file

w

4. A window will open where you have to specify the Coordinate Reference System (CRS) of this
input map. It does not yet have a CRS, so you can click Cancel.

4.5 Setting the transformation parameters
First we have to set the transformation settings (see also screenshot on next page).

1. Inthe menu choose Settings = Transformation Settings...
2. Here you can choose:

a.

Different transformation types. A simple linear transformation can be used if the
map is not much deformed. The other ones can be tried when more deformation
exists. We will start with a linear transformation.

Resampling method: if you need the pixel values in further calculations, it is best to
choose the nearest neighbour option. This resampling method will preserve as much
as possible the original pixel values by choosing the nearest one. Visually, however,
this method results in a “blocky” map. If the purpose is only for visual use, for
example as a backdrop for digitization of vector layers, then it is better to choose
another resampling method. Here we will use the cubic method, which uses the
average of the 4 nearest pixels.

Target SRS: here choose the code that you have noted before; EPSG:26718. You

-

can choose it by clicking “&l and using typing 26718 in the filter field.

Browse to the folder where you want to save the georeferenced map. The tool automatically

adds modified to the file name. So in our case the georeferenced file will be named

D:\QGIS Exercises\Exercise 1\Mount Marcy New York USGS topo map
1979 modified.tif
Keep the other settings on default and check the box Load in QGIS when done. The dialogue

should look like the one below.
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» Transformation Settings

—Transformation parameters

Transformation type [T ~ |

Resampling method ICubic ;I

Target SRS |EPSG:26718 - NAD27 / UTM z0ne 18N = 8|
—Output settings

Output raster ID:IQGIS_Exen:isesExerl:isE_1,;’Ml::unt_Marr:y_New_'1'l::rk_USGS_bJpD_map_lQ?Q_modiﬁEd.h'f |

Compression INone j
™ Create world file only {linear transforms)

[” Useofor transparency when needed
[” set target resolution

Horizontal |0.00000 =
Vertical |-1.00000 =]
—Reports
Generate PDF map I

|
Generate POF report I _I

¥ Loadin QGIS when done

0K | Cancel | Help |

4.6 Adding Ground Control Points (GCPs)
In order to link the file coordinates to real world coordinates, we need to indicate Ground Control
Points (GCPs) with known coordinates. We can derive these coordinates in different ways:

e The easiest way is to use the coordinate grid on the scanned map if this is available and if it is
in a known projection. We click on a node in the grid and type the corresponding X and Y
coordinates in the dialogue.

e Using a reference map in the QGIS map canvas that has already been georeferenced. In this
way we can obtain the right coordinates by clicking on the reference map.

e Using GCPs that were measured in the field using a GPS.

Here we will use the coordinate grid that is printed on the map.

1. Zoom in on the node with coordinate 581000 East and 4885000 North.
2. Click the Add Point button *% to add a GCP.

11



3. Enter the map coordinates in the pop-up window:

! Enter Map Coordinates

Enter X and Y coordinates (DMS (&d mym s5.55), DD (dd.&d) or projected coordinates (myrvmrmm))
which correspond with the selected point on the image. Alternatively, click the button with icon of a
pencil and then click a corresponding point on map canvas of QGIS to fill in coordinates of that point.

X / East |581000 Y / North 4885000
oK I £ From map Gmrasl Cancel

If you have a reference map in the QGIS map canvas, you can use the From map canvas
button to capture the coordinate and perform an image to image georeferencing. Here we
will only type the coordinates form the map grid.

24

4. Press OK. Now your screen should look like this:

» Georeferencer - Mount_Marcy_New_York_USGS_topo_map_1979.JPG

File Edit View Settings

|| > LG

3652350 2 2 P S 5[~ [ e
MOUNT MARCY, NEW YORK  ESSEX COUNTY

581 000mE 582 533
T e Ranger— L L g W

rm* \\

Visible I D Source X Source Y Dest. X Dest. Y dX (pixels) dY (pixels) I Residual (pixels) I
0 338.473 -365.515 581000 4885&+06‘ 0 0 0|

: Transform: Linear Translation (0, 0) Scale (9.34606e-307, 3.69126e-317) Rotation: 0 ; 546.9,-150.4 | None A

The red dot is the location that you have referenced. In the table below the map, you can see
the Source X and Source Y coordinates. These are the unreferenced file coordinates. Their
values depend on which pixel you clicked for placing the GCP, so it can differ from the
screenshot above. Dest. X and Dest. Y show the real world coordinates that you have linked
to this location. The other fields of the table have to do with estimated accuracy and will be
filled in after adding more points.

5. Let’s choose a second GCP in the upper right corner of the map and proceed in a similar way
as with the first GCP. Your screen should look like this:
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w Georeferencer - Mount_Marcy_New_York_USGS5_topo_map_1979.JPG

File Edit View Settings
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GCP table g X
Visible D Source X Source Y Dest. X Dest. Y dx (pixels) dY (pixels) Residual (pixels)
=] i 338.473 -363.515 581000| 4.885e+06 4.04157e-11 -1.866172-09 1.866612-09
il 3883.52 -215.015 599000| 4.886e+06 B8.32188e-11 -2.56591e-09 2.56726e-09

| Transform: Linear Translation (579281, 4.88743e+06) Scale (5.07751, 6.64449) Rotation: 0 Mean error: 0 | 4158.7,-102.7 | Mone

2|

You can see that some error statistics have been calculated. With only two points this does

4.

not make much sense. The minimum amount of GCPs for a linear transformation should be

Add in a similar way a GCP in the lower left and the lower right corner of the map. If you

made a mistake you can remove the GCP by using the Delete point button

should look like this:

s Georeferencer - Mount_Marcy_New_York_USGS_topo_map_1979.JPG

=
& . Your screen
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Visible D Source X Source Y Dest. X Dest. Y dX (pixels) dy (pixels) Residual (pixels)
0 338.473 -365.515 581000 4.885e+06 -15.6765 23.6178 28.347
= 1 3883.52 -215.015 599000 4.886e+06 -17.2501 1 -22.7089 28.5177
= 2 4046.49 -2776.51 600000 4.873e+06 16.6324 1 -25.4464 30.3999
= 3 306.503 -2726.52 581000 4.873e+06 16.2942 ! 24.5376 29.4549
\ Transform: Linear Translation (579360, 4.88698e+06) Scale (5.07977, 5.08059) Rotation: 0 Mean error: 41.2829 354,-2568 ‘ None A
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At the bottom of the screen you can see the estimated mean error (40.2829 pixels in our
case). The error is also visualized at the GCPs using a red line. Obviously your values will not
be exactly the same.

There are two ways to reduce the error:

;f
a. Usethe e button (move GCP point) to place the GCPs really at the nodes where

the grid lines cross. You need to zoom in to select the right pixel. Note that the mean
error is not automatically updated. You need to change the transformation type to
something else and then back.

b. If option a. doesn’t reduce the error, we can change the transformation type. If we
change to another transformation type in the transformation settings, the error
values will be recalculated.

We’ll apply option b.

7. Inthe menu go again to Settings = Transformation Settings... and now let’s select a 1° order
polynomial (Polyniomial 1) instead of the linear transformation. Keep the rest as it was. Click
OK to return to the GCP table. Now you can see that the mean error has been reduced to a
fraction of a pixel, which is acceptable. If you don’t see a mean error < 1 pixel, than you have
to check the GCP locations and correct them.

8. Now we can start georeferencing using the button. After some calculation time the
georeferenced map appears in the QGIS map canvas. You can close the Georeferencing
plugin. It will ask if you want to save your GCPs. You can click Discard if you don’t want to use
them. If you save them, you can load them again in the Georeferencing plugin.

9. In order to verify the result you can use the Coordinate Capture plugin. If it is not activated
yet you can do it by choosing from the menu: Plugins - Manage and Install Plugins... . Then
search for the Coordinate Capture plugin and check the box to activate and click Close:

2 Plugins | All (275) ?
| 2 coord a
# Azimuth and Distance Calculator This is a core plugin, so you can't uninstall it
# CoordGuesser
m Coordinate Capture COO rd i na te ca ptu re
’- Not installed = Coordtransform
# Geo2Local Capt dinates in diff t CRS
zﬁ'i Upgradeable # ICSM NTv2 Transformer apture mouse coordinates in differen
: # Indicatrix mapper
'* Invalid : Lgt Lon Tools Category Vector
. ® RiverMetrics Installed version Version 0.1
%5 Instal from ZIP # zoomtopaste
# Settings
i | i

Upgrade Al Uninstall Plugin | Reinstall plugin |

Help |

Close
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10. A panel has appeared under the layers list. Here you click on Start capture. Click on a grid
node in the map and the coordinates are displayed in the panel:

Coordinate Capture g X

©| [73.08733,24.11572

[l [ss1001.719,4885001.306

¥ Copy to Clipboard

—:!- Start capture

The first field shows the coordinates in the Geographic Reference System (Lat/Lon
coordinates), the second field shows the coordinates in the projection of the project.
Read the coordinates from the side of the map and verify if they are correct.

Another way to verify the result is to use the web maps as a backdrop. The QuickMapServices plugin
provides easy access to many web maps such as Google satellite and OpenStreetMap.

11. If not yet installed, install the QuickMapServices plugin: in the main menu choose Plugins >
Manage and Install Plugins... and search for the QuickMapServices plugin and install.

12. After installing, choose from the main menu Web - QuickMapServices plugin - Settings

13. Now choose the More services tab and click Get contributed pack. Click Save when the
contributed pack is installed. This will give you access to many more useful web maps.

o QuickMapServices Settings T

General ] Tiles ] Add\Edit\Remove ] Visibility =~ More services l

Attention!

Contributed services definitions are provided 'as is' and are not
validated by plugin authors. These are proof-of-concept and for

testing only. Visit https://github.com/nextais/

quickmapservices contrib to add new services. Use at your own

risk!

Get contributed pack |

Cancel
14. Go back to the main menu and choose Web = QuickMapServices plugin and try some of the

options.
15. This is a good moment to save your QGIS project ( . ggz file). Choose from the main menu
Project > Save as... and save it as
D:\QGIS Exercises\Exercise 1\Exercise 1l.qggz.
The project file contains references to all layers, styles, projections, extent and zoom level of the Map

Canvas. Save your project regularly!
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4.7 Digitizing vector layers from a georeferenced backdrop
Our georeferenced scanned map can now be used as a backdrop to digitize vector layers. Vectors can
be points, (poly)lines or polygons. In this exercise we are going to digitize:

e Mountain tops as points

e Rivers as (poly)lines

e Lakes as polygons
We will create these vector layers in a GeoPackage spatial database. In that way we have all layers
together in one file, instead of using separate shapefiles.

The following steps guide you through the process.

1. First we have to create an empty shapefile. In the main menu select Layer - Create Layer
- New GeoPackage Layer-...

Project Edit View | Layer Settings Plugins Vector Raster Database Web Processing Help

JJ D Eﬂ Data Source Manager Ctrl+L h SR ONANANRNILNLE=| |||i

@’ New GeoPackage Layer... Crrl+-Shift+M
”m % Vo ,(5 Add Layer * W New Shapefile Layer...

” OODO - &2 ’ Embed Layers and Gr.t}-ups.... f New Spatialite Layer...
Add from Layer Definition File... # New Temporary Scratch Layer. ..
Browser
2. Inthe New GeoPackage Layer dialogue 2 New GeoPackage Layer

we first select the Database filename by

Database |D:\QGIS_ExercLses\ExercLse_l\Mount_Marqr.gpkg a _I |
clicking —I . Then browse to the folder e o i
where you want to store the Geometry type [~ Pomt |
GeoPackage and save it to ™ Include Z dimension I Indude M values
D:\QGIS_Exercises\ |EPSG:26718 - NAD27 / UTM zone 18N =l &
Exercise 1\Mount Marcy.gpkg. B
For Table name we choose Peaks. For Name |
Geometry type we choose Point. Make — [+2 Decal number (rea) ]

sure EPSG:26718 is chosen as Maximum length |

projection. Add to fields list |

3. Create a new field with the Name

Elevation, Type Decimal number [ Flelds st
. —~ f Name Type Length |
(real) and click _ .. Add to fields st | Elevation real
4. Click OK. Remove field |

5. The empty layer has now been added to

your layers list. ok | cncel | Heb

» Advanced options ZI

Layers J X
@@ Tg~F AL
® Peaks

16



10.

11.

12.

In order to start digitizing, you have to toggle to edit mode. Click on the Peaks layer so it is
selected.

Click on ¥ to toggle to editing mode. Now the other editing buttons become active and a
pencil before the layer name shows that we are editing the layer.

In the topographical map navigate to a spot height of a mountain. They are indicated with x

and an elevation value. If you have found one, zoom in and click the Add Feature button®® .

Move the mouse to the mountain top. The cursor changes in a crosshair. Click on the
mountain top.

A dialogue with a form shows up. £id is the feature id that is automatically generated. It’s a
unique integer number for each feature. The other attribute that we have to fill in is
Elevation. We typethere 738 in this case.

i

e |

fid |Aut0genemte 8 v

Elevation |738 a
= l

G2

Repeat this step for a few other peaks. If you made a mistake, you can use the vertex tool

* to move the feature or use one of the select options to select the point feature

I
- - 0, B %

a i1y Select Feature(s)
'";; Select Features by Polygon
- I select Features by Freehand
i3 Select Features by Radius

and click @ to delete the selected point feature. These buttons 1? can be used to

undo/redo something. Use B to save the edits.

When done, click again on the # button to toggle editing. If you didn’t save edits yet, it will
ask you to Save or Discard. With Discard you can always undo your edits until the last time it
was saved.
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13. You can check the attribute table of your new point vector layer by right clicking on the layer
name (Peaks) and selecting Open Attribute Table

14.

15.

- Spatialite B
- @ Postels 0 Zoom to Layer
- P> mssaL ) Zoom to Selection
- ® once T Show in Overview
-3 a2
B §® WMS/WMTS Show Feature Count
- XVZ Tiles Copy Layer
@ WCS Rename Layer
@ Wrs
-0 OWS [} Duplicate Layer

- &% ArcGisMapSery [l Remaove Layer...

- & ArcGisFeatures
- 5f¢ GeoNode

& Open Attribute Table I ! Peaks :: Features Total: 4, Filtered: 4, Selected: 0

J/ Toggle Editing J B R|ET | & A T ES D] E=E|a
B fid Elevation
Set Layer Scale Visibility... 1 4 1.068
Set CRS L4
2 3 594,9
Export 4
Layers & x |3 2 0578
Styles 4
d m i Y S”v Properties... 4 ! 78
B Mount_Marcy_New_York_USGS_topo_m... Ml _l_‘

Now you can see the attributes that you have added and their fid and elevation values.

Our next task is to digitize line features. The procedure is similar to creating a point layer. In

the New GeoPackage Layer dia

logue first browse to the existing Database

D:\QGIS Exercises\Exercise 1\Mount Marcy.gpkg. Give a new Table name:
Rivers and Geometry type Line
As a new attribute we add Name with the type Text data. Check if the dialogue resembles

the one below and click OK.

= New GeoPackage Layer

Database
Table name

Geometry type

—HNew field

|D:\QGIS_ExercLses\ExercLse_l\Mount_Marcy.gpkg | ]

| Rivers

| o Line j

[~ Include Z dimension I~ Include M values
=l #f

IEPSG:25?18 - NAD27 [ UTM zone 18N

Mame

Type

Maximum length |

fabe Text data |

Add to fields list |

— Fields list
Mame Type Length I
Name text
Remove field |

» Advanced options zl

[ o |

Cancel | Help
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16. QGIS will tell you that the file already exists and if you want to overwrite the database or add
the new layer. Obviously, we choose Add new layer.

»! Mew GeoPackage Layer

0 The File already exists. Do you want to overwrite the existing file with a new

database or add a new layer to it?

Owerwrite Add new layer

17. Click on * to add a new line feature. Zoom and pan on the map to find a stream to digitize.

18. Click on the starting point of the line (node) and click when necessary to make a vertex. You
can use the zoom and pan buttons to trace the stream. You can also change the symbology
to visualize clearer the line that you are digitizing. After you placed the end node of the line,
click right. You can use the spacebar to pan during digitizing.

19. In the dialogue, fill in the name of the river.

Rivers - Feature Atinbutes x

Actions
fid  |Autogenerate & v
MNarme |Big Sally Brook &

0K | Cancel

20. Repeat these steps for a few streams and save your edits. Check the attribute table.
Extra:
e If you want to add tributaries that connect to streams, play around with the snapping
settings (Click right on a toolbar and choose Snapping Toolbar).
e Try to find out how to combine all tributaries into one river feature.

21. Finally we are going to create a polygon vector layer for some lakes. Try to find out yourself
how to do this. It is very similar to the procedure for lines. The only difference is that the first
node should be the same as the last node in order to close the polygon.

Extra:
e Try to find out how to deal with islands in the lakes

4.8 Image to image registration
Try to use the Georeferencer plugin to register the scanned map (JPG file) to a satellite image
from the QuickMapServices Plugin. In this way you can perform an image to image registration.
Please make sure you use the right projection. Does the image to image registration give better
results?

This whole exercise can be viewed in a screencast
at: https.//youtu.be/m12ZXpGBoDc
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Exercise 2: Importing tabular data into
GIS and interpolation
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5 Importing tabular data into a GIS

5.1 Introduction

After this exercise you are able to import tabular data into a GIS. In this example we are going to
import a table with the daily average temperature on September 1st 2013 at several meteorological
stations in the Netherlands. The data was downloaded from the KNMI Data Centre (KNMI, the Royal
Netherlands Meteorological Institute, http://data.knmi.nl), but reformatted for the purpose of this
exercise.

In this exercise we'll use the following data:

e KNMI 20130901 tday.xls:table with average daily temperatures for different stations
e KNMI stations.xls:table with station number and coordinates of the location of the
stations

This data can be downloaded from the OpenCourseWare website (http://ocw.unesco-

ihe.org/course/view.php?id=11). You can find the data under Data Exercise 2. You can save the files

under D: \QGIS Exercises\Exercise 2.

This exercise will guide you through the following steps:

Join table

Import with data to Recalculate

values in an

Reproject
dataset to
[oler:]
projection

Interpolate
points to
raster

tables into vector layer
GIS with
locations

attribute
table

5.2 Convert Excel table to GIS format
There are different ways in QGIS to import tabular data:

, Add delimited text layer: this is the standard importer that requires a comma separated ASCI|
S file.

E Spreadsheet layers plugin. This tool can open spreadsheet files (*.ods, *.xls, *.xIsx) with some
options (use header at first line, ignore some rows and optionally load geometry from x and y
fields).

In this exercise we’ll use the Spreadsheet layers plugin

1. Openthe files KNMI 20130901 tday.xlsand KNMI stations.xlsina
spreadsheet program (e.g. MS Excel) and check the contents. Which file contains
coordinates? Is there a way to link both files? How could we do that?

2. Start QGIS Desktop (make sure you start a new project and not continue the previous one).

3. Inthe menu go to Plugins - Manage and install plugins... and check if Spreadsheet layers
plugin is installed. If not, you should install the plugin. Plugins are developed by the
community to add extra functionality to QGIS. With the Spreadsheet layers plugin you can
import from/export to Excel files for example.
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| O spre

I , Spreadsheet Layers

— Spreadsheet Layers [
Not installed Load layers from spreadsheet files (*.ods,
* xls, *.xlsx)
Upgradeable
This plugin adds a "Add spreadsheet layer" entry in
Invalid "Layer" / "Add new Layer" menu and a corresponding
button in the "Layers" toolbar.
T These two links open the same dialog to load a layer

from a spreadsheet file (*.ods, *.xls, *.xlsx) with some
options (use header at first line, ignore some rows and
- | 3

« . |
Uninstall Pluginl Reinstall plugin |

Close | Help

Settings

4. Now in the menu choose Layer - Add Layer = Add spreadsheet layer

Layer Settings Plugins Vector Raster Dafabase Web Processing Help

19 Data Source Manager Ctri+L : Fn gj g:} ;a J\_ [E “:E [];W] e U ﬁ

Create Layer T

add Layer 4 V,; Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... B, Add Raster Layer... Ctri+Shift+R
Add from Layer Definition File... 9, Add Delimited Text Layer...
' Copy Style W, Add PostGIS Layers... CtrhShift+D
Paste Style /% Add Spatialite Layer... Ctri+Shift+L
R Add MSSQL Spatial Layer... Ctrl+Shift+M
< Copy Layer [T, Add DB2 Spatial Layer... CtrhShift+2
Paste Layer/Group ) )
@, Add Oracle Spatial Layer... Ctri+5hift+0
=| Open Attribute Table Fa Wl Add/Edit virtual Layer...
|7 Toggle Editing €% Add WMS/WMTS Layer... CtrhShift+\W
[} save Layer Edits @ Add ArcGIS MapServer Layer...
# Current Edits ¥ &3 Add WCS Layer...
Save As.. ; Add WFS Laver...
Save As Layer Definition Fe... %7 Add ArcGIS FeatureServer Layer...
[l Remove Layer/Group CtrhD

5. Inthe dialogue browse to the file with the locations of the meteorological stations
(KNMI_ stations.xls).

6. Fillin the dialogue as below. Make sure the right Geometry Fields and Reference system are
chosen. Also indicate the data types correctly for the fields. E.g. STN are station numbers
and should be imported as Integer, while ALT (m) should be imported as Real numbers.
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»| Create a Layer from a Spreadsheet File

File Mame |D:,I'QGIS_ExercLsesjExerclse_ﬂKNMI_sutions.xls Browse... |
Sheet |sheet1 |
Layer name |KNMI_slzti0n5_t7:|bIe
Rows Mumber of lines to ignore IE ™ Header at first line ¥ End of file detection
¥ Geometry
Fields X field |LON | vfield [LAT »| I” show fields in attribute table
Reference system |Project CRS: EPSG:4326 - WGS 84 = ﬁl
STH LON LAT ALT(rn) HAME 2]
Integer ;ﬂ Real Lﬁ Real Lﬂ Real j String j
1 210.0 4.419 52.165|-0.20 VALKENBURG
2 225.0 4,573 52,462 4.40 OMUIDEN
3 235.0 4.785 52.9240.50 DE KOOY
4 240.0 4,774 52.301|4.40 SCHIPHOL
5 242.0 4.942 53.255/0.90 VLIELAND
6 249.0 4.979 52.644 | -2.50 BERKHOUT
7 251.0 5.346 53.302|0.50 F%%E'EHELLING)
8 257.0 4.603 52.506|10.00 WIK AAN ZEE
] 260.0 5.177 52.1012.00 DE BILT
10 265.0 5.274 52.13|13.90 SOESTERBERG
11 267.0 5.384 52.896 2.60 STAVOREN
12 269.0 5.526 52.458|-4.00 LELYSTAD LI
Help | oK | Cancel |

7. Now a map with the meteorological stations is displayed. If you don't see the map, you
probably need to zoom to the extent of the map: click right on the layer name
(KNMI_stations_table) and choose Zoom to layer.

8. Now add the table with the temperature data in the same way. Because there is no
geometry (coordinates) in the table, we should uncheck the box:

»| Create a Layer from a Spreadsheet File

File Name | D/ QGIS_Exercises/Exercise_2/KNMI_20130901_tday.xls

Sheet [sheet2

Layer name | KMMI_temperatures_table

Rows Number of lines to ignore IU 3: ™ Header at first line
I~ Geometry
Fields X field | | ¥ field [yyyyMMDD

Reference systemn Iin\falid projection

5TH YYYYMMDD T(0.1C)
Integer = || Integer j Real j
1 210.0 20130901 182.0
2 225.0 20130901 VLILL
3 235.0 20130901 158.0
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The next step is to convert KNMI_stations_table to a GIS vector format, i.e. shapefile. Click
right on KNMI_stations_table and choose Export > Save Features as...

. In the dialogue use the J button to browse to the folder to save the file as
KNMI stations.shp. In order to change the projection to the local Dutch projection

choose for CRS "Selected CRS" and Browse to Amersfoort / RD New by clicking on the
button. Tip: use the Filter field to lookup EPSG code 28992:

= Coordinate Reference System Selector

Select the coordinate reference system for the vector file, The data points will be transformed from the layer
coordinate reference system.

Fiter | ©. 28992 a

Recently used coordinate reference systems

Coordinate Reference System Authority ID
Amersfoort [ RD New EPSG:28992

1| |ﬂ

Coordinate reference systems of the world [™ Hide deprecated CRSs

Coordinate Reference System Authority ID
- [l Projected Coordinate Systems
-I- Obligue Stereographic Alternative

Amersfoort [ RD New EPSG:28992

4| |ﬂ

Selected CRS |Amersfoort / RD New

Proj4: +proj=sterea

+lat_0=52.15616055555555
+on_0=5.38763888888889 +k=0.9993079%
+x_0=155000 +y_0=463000 +elps=bessel j

Extent: 3.20, 50.75, 7.22, 53.70 j

oK | Cancel | Help |

Here you see the advantage of using EPSG codes: it standardizes the projection. So it is useful
to determine the EPSG code of the projection you want to work within your project. Also note
that all maps in your project need to be in the same projection if you want to combine them
in a GIS analysis or modelling.
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Click OK. Now the dialogue looks

like the figure (also check the box

Add saved file to map and make

sure that ESRI Shapefileis

chosen as the Format).

Click OK to proceed.
11. Remove the knmi_stations_table
from the display by clicking right
and selecting Remove Layer... .
Click OK to confirm. Be sure to
remove the right one. If you
hover your mouse over the layer
name it will show the file name.
With Remove you only remove it
from the display, the file will still
be on your hard disk.

»! Save Vector Layer as...

Format |ESRI Shapefile |
File name |D:\QGIS_Exercises\E:-:ercise_E\KNMI_smtions.shp & J
Layer name |
CRS |EPSG:28902 - Amarsfaort / RD New | &
Encoding |UTF-8 |
I Save only selected features
I+ Add saved file to map
P Salect fields to export and their export options
¥ Geometry

Geometry type |.-'-\utumatic j

™ Force multi-type

I Include z-dimension
P [ Extent (current: layer)
P Layer Options
P Custom Options

oK Cancel | Help

12. Although the knmi stations.shp dataset is in the EPSG 28992 projection (Amersfoort /
RD New), the QGIS Map Canvas still uses the EPSG 4326 projection (lat/lon WGS 84) and has
reprojected knmi stations.shp on the fly for visualisation. In order to visualise all
layers in EPSG 28992 we have to change the QGIS Project properties. In the menu choose

Project - Properties...

13. Choose the Coordinate Reference System (CRS) tab.

14. Choose from the recently used coordinate reference systems EPSG:28992 and click OK.
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»! Project Properties | CRS

— Project Coordinate Reference System (CRS)

™ Mo projection (or unknown/non-Earth projection)

Filcer | .

Recently used coordinate reference systems

Coordinate Reference System Authority ID
WGES 84 EP5G:4326

.“' Default Styles WGS 84 / UTM zone 195 EP5G:32719

WGES 84 / UTM zone 31N EPS5G:32631

S WGS 84 / UTM zone 321 EPSG:32632

B 1dentify Layers WGS 84 / UTM zone 375 EPSG:32737

— MAD27 f UTM zone 18N EP5G:26718

BE Data Sources Amersfoort / RD New EPS5G:28992
EE Relations o ILI
Coordinate reference systems of the world ™ Hide deprecated CRSs

Variables

Coordinate Reference System IAuthority D ;I

{_1@( Macros - World_Hatine EPSG:54025
. - Obligue Stereographic Alternative —

- ATST7 [ Mew Brunswick Stereographic (ATS77) EPSG:2200

ATS77 [ Prince Edward Isl. Stereographic (ATS77) EPSG:2290

Amersfoort /| RD New EPSG:28992

- Amersfoort / RD New EPSG:7415 | v
» |

E QGIS Server

‘

Selected CRS |Amer5f00rt,‘ RD Mew

Extent: 3.20, 50.75, 7.22, 53.70

Proj4: +proj=sterea +ht_0=52.15616055555555

+lon_0=5.38763888888889 +k=0.9999079

+x_0=155000 +y_0=463000 +elps=bessel +
+towgsB4=565.2369,50.0087,465.658,-0.406857,0.3

50733,-1.87035,4.0812 +units=m +no_deafs

— Datum transformations

[~ Ask for datum transformation if several are avaiable (defined in global setting)

2| =/

Source CRS I Source datum transform | Destination CRS Destination datum transform

0K I Cancel | Apply Help

Note that the projection of the project is indicated in the lower right of the screen

) EPSG:28992 | yo can always check there if the EPSG code is okay. You can change the
on-the-fly projection also by clicking on that EPSG code.

5.3 Join attribute tables

We still have the locations of the stations and the temperature data in separate tables. We have to
combine them in one shape file. In GIS terms this is called a "join" operation. We can only join tables
if they have a column in common.

15. Check the attribute table of KNMI stations (right clickon KNMI stations and choose
Open attribute table) and in the same way check the KNMI temperatures table.
Which column both attribute tables have in common?

After determining which column both tables have in common we can join the data of
KNMI temperatures table to the attributes of our shapefile KNMI stations.shp.
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16. First close the attribute tables.

17. Next, click right on KNMI stations and choose Properties.

L
18. In the dialogue choose the button Joins ‘ .

19. Click the + sign and choose check if the dialogue looks like this one:

» Add Vector Join

Join layer KMMI_temperatures_table j
Join field [1235y -
Target field I 1235TH j

v cache join layer in virtual memory
I™ Create attribute index on join field
r Dynamic form
w [ Editable join layer

r psert on edit

I Delete cascade

w [v Joined Fields

] STN
O] YYYYMMDD
T(0.1C)

w v Custom Field Name Prefix

ITempL

QK Cancel

Note that the common field is STN (the station number), we join only the temperature field
and we give the column the prefix Temp . Click OK.
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20. Now the Joins dialogue looks like this:

» Layer Properties

i
5
=
v
s
-

1
=

F /
=

Inforrmation

Source

Symbology

Labels

Diagrams

3D View

Source Fields

Attributes Form

@ Actions

5,

Display

Rendering

MMI_stations | Joins

Setting Value

={Join layer KNMI_temperatures_table
Join field STH
Target field ST

Cache join layer in virtual memory «

Dynarnic form
Editable join layer
Upsert on edit
Delete cascade

Custom field name prefix

- Joined fields

2| =| /]

- Style - |

Temp_

[ o |

Cancel

Help

Click OK to perform the Join operation.

21. Now check again the attribute table of KNMI stations. What happened?

22. First we need to remove the missing values. Click on row numbers with NULL or no values
for temperature, while keeping the Ctr1 button pressed. Now the attribute table looks like

this:
STH ALT(rm) NAME Temp_T(0.1C) LI
4.4000000000... | DMUIDEN
24 275| 50.000000000... | DEELEN 135
23 277( 3.0000000000._.. | LAUWERSOOG 161
26 380 114.00000000... MAASTRICHT 136
27 2701 1.5000000000... | LEEUWARDEN 152
28 391 19.000000000... ARCEN 139
29 273| -3.100000000... |MARKNESSE 152
30 375 21.100000000... VOLKEL 141
3 267 | 2.6000000000... | STAVOREN 158
32 377 30.000000000... ELL 138
33 269| -4.000000000... |LELYSTAD 148
34 260| 2.0000000000... |DE BILT 143 —
265] 13.900000000... | SOESTERBERG LI
T Show All Features, = | =
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23.
24.

25.

26.

27.

In the attribute table click on above the table to toggle editing mode.

-

Click the @' icon (in the toolbar above the attribute table) to remove the 2 features with

missing data and save the attribute table by clicking =

The only problem now is that the temperatures in the table are in 0.1 °C. We need to convert
the values to °C.

Click the New field button E] to add a new column to the table. And fill in the dialogue
according to this screenshot:

~ Add Field

Name |T(C)

Comment |Tempemture in Celcius

Type |Decima| number (real) j
Provider type double

Length E =
Precision |1 :l

0K Cancel ‘

Length is the amount of numbers, Precision is the amount of decimals.
Click OK to proceed.

Now the attribute table shows an extra column with NULL values. In order to calculate the

right values click above the table to open the Field Calculator dialogue.

Fill the dialogue like the screenshot below. To avoid typos the best practice is to double click
on the field name in the middle of the dialogue screen and to click the * button. Then type
0.1. Click OK to proceed.

w! Expression Dialog

Expression l Function Editor ]

T U Y e ,

Fields and Values Double-click to add field

w f AL

Temp_T(0.1C) 0.1 123 STH name to expression string.
12 ALT(m) J Right-Click on field name to
MULL open context menu sample
abc NAME value loading options.
12 T(C)

Notes

Loading field values from WFS
layers isn't supported, before

Al Unique ‘ 10 Samples ‘ the layer is actually inserted,
ie. when building gueries,

Values | O Search...

Qutput preview: 16.2

oK Cancel Help
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28.

Make sure the Attribute table window looks like below. Please note that T (C) should be
indicated as column to assign the calculation to! Click Update All.

v KMMI_stations :: Features Total: 36, Filtered: 34, Selected:

JEB D<o B § LTELQRD BERE =6 &

12700 ~]= €[] Temp_T(0.10)" =01 ~| update Al | Update Selected
STN atm) | nave | Temp T0a0) | T | Al

1 210 -0.200000000...| VALKENBURG 162 16.2

2 235 0.5000000000... DE KOOY 158 15.8

3 240 -4.400000000...| SCHIPHOL 154 15.4

4 242 0.9000000000... VLIELAND 161 16.1

5 249 -2.500000000...| BERKHOUT 147 14.7

6 251 0.5000000000... [H'IE}E[;.EEHELLINE} 153 15.3

7 257 10.000000000... WIK AAN ZEE 162 16.2

8 260 2.0000000000...| DE BILT 143 14.3

9 267 | 2.6000000000...| STAVOREN 158 15.8

10 269 -4.000000000... LELYSTAD 148 14.8

11 270 1.5000000000...| LEEUWARDEN 152 15.2

12 273 -3.100000000... MARKNESSE 152 152 |

T Show Al Features,| Bl =

29. Now check the result in the attribute table.

30. Click again on the to toggle back to non-editing mode. Click Save to save the changes
when asked and close the attribute table. If you made a mistake, don’t save, but instead

choose Discard to undo all changes since last save.

31.

Now remove the table KNMI temperatures table and check the attribute table of

KNMI_stations. What columns do you see now? What can you conclude about the join

function? You could have saved the entire attribute table by saving KNMI_stations to a new

shapefile using the previously used Export = Save as... function.

5.4

Interpolate point features to raster

32. The final task is to interpolate the temperature values to a raster. In the menu choose
Raster > Analysis > Grid (Nearest Neighbor).
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33.

34.

35.

Raster Database Web Processing Help

¥ Raster Calculator...
Align Rasters...
11 Georeferencer...

DRLALBHI e
B EXYEE

be
s ]
Projections » 4 Fil nodata... \.
Miscellaneous * & Grid (Moving Average)...
Extraction " [ Grid (Data Metrics)
SR ' i’, Grid (Inverse Distance to a Power)...
"9 Grid (Mearest Neighbor)...
% Hilshade..
1] Near Black...
k ? Proximity (Raster Distance)...
7w Roughness...
W Sieve..
o Slope..
% Topographic Position Index (TPI)...
7w Terrain Ruggedness Index (TRI)...

In the dialogue specify the output
file: tday NN.tif by usingthe
browse window and specifying
the . tif format.

Select T (C) asZvalue from
field. This is the field that we will
interpolate to Thiessen polygons.
Check the Open output file after
running algorithm checkbox.

For the rest of the dialogue keep
the defaults. The dialogue should
now look like the figure.

Note that the dialogue generates a
GDAL command.

Click Run to proceed.

Click Close to close the dialogue.

The interpolated temperature map
is now loaded into the display. It is
visualised in greyscale, so you have
to set the visualisation options.
Click right on the map and select
Properties.

Under the Symbology tab, play
around with the different options
and click OK to return to the
display.

» Grid (Mearest Neighbor)

Farameters I Log I

Foint layer

[ - knm_stations [EPsG:28992]

I™ selected features only

The first radius of search elipse

J0.000000

LL

The second radius of search ellipse

|0.000000
Angle of search ellipse rotation in degrees (counter dodkwise)

bl L

|0.000000
MNODATA marker to fill empty points

Ll._

f0.000000

w Advanced parameters

Z value from field [optional]

j12110) =

Additional creation options [optional]

Profile IDehuIt

Mame | Value |

Help

il El Validate |

Output data type
|Float32

Interpolated (Nearest neighbor)
ID 1 [QGIS_Exercises Exercise_2/T_NM. tif

L

v QOpen output file after running algorithm
GDALfOGR. console call

gdal_grid - KNMI_stations -zfield T(C) -a

nearest:radius 1=0.0:radius2=0.0:angle =0.0:nodata=0.0 -ot Float32 -of GTiff Z:
YQGIS_Exercises\Exercise_2WNMI_stations.shp D: /QGIS_ExercisesExercise_2f
T_NN. 6f

Run as Batch Process. .. | Cloze | Help

0% Cancel |
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36. Now dragthe knmi stations file to the top in order to display the stations on top of the
temperature grid.

37. Click right on the knmi stations layer and select Properties.
38. Select the Labels icon and choose Single labels. Choose T (C) as the Field containing the

label. Play around with the placement options (see screenshot below) to make a nice map.
Click Apply to test and OK to visualise.

« Layer Properties - KNM|_stations | Labels

I %4 Single bels j @" |

Information Label with I_.l_2 Q) j il
A Source w Text Sample
Lorem Ipsum il
& Symbology
[
Lorem Ipsum 2' |1:1.248.584 ~| El |v
Di s —
SO abe Text Placement
3D View :alé Formatting .
abe Buffer
Source Fields @ sackaround " Cartographic * Around peint ¢ Offset from point
Shadow
Attrbutes Form ‘;)
#.% Placement i
Joins / Rendering Distance |U,9£]£]£] 35 &
§ Milimet =
ﬂ Auxiliary Storage I flimeter ~ &
Quadrant ¢,
{Q Actions
® ooy <

d."’ o - Style *l oK I Cancel | Apply | Help

39. Now repeat the interpolation using the Inverse distance to a power (IDW) algorithm (repeat
from step 32). Call the result file tday IDW.tif. Visualise the result. Which interpolation
method is better? Why? Can you explain the temperature gradient in the map?
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40. You can save your QGIS project at this point by choosing from the menu Project - Save as....

41.

42.

Now you can close QGIS and load the project the next time you use QGIS.

We can also plot our newly created GIS data over a topographical map. For this purpose you
have to install the QuickMapServices Plugin. In the menu go to Plugins - Manage and
install plugins... and install the QuickMapServices plugin if it is not yet installed. You can also

install the experimental additional services. You can do that under Web - QuickMapServices
-> Settings.

Choose from the menu Web - QuickMapServices > OSM - OSM Standard. Make sure
your point vector layer is on top.

Extra:
Try to repeat the first part of the exercise with the default QGIS importer for comma
separated files.

This whole exercise can be viewed in a screencast
at: https.//youtu.be/PxLufyv)9jA
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Exercise 3: Importing data from a GPS
and conversion to vector layers
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6 Importing data from a GPS and conversion to vector layers

6.1 Introduction
In this exercise you will learn how to collect data from a GPS, import the data into QGIS and create

point, line and polygon vector layers.

6.2 Preparing the survey
Before going in the field it is important to be well prepared. Fieldwork is expensive and you want to
prevent that you will have to go back. In the next sections there are some guidelines.

6.2.1 Preparation of maps
Use a GIS to prepare the following maps before going to the field:

e Use available maps to understand the study area

e Decide on the map projection that you want to use and look for the EPSG code

(http://www.spatialreference.org or http://epsg.io:

O

Local projection: if your study area is in one country, you can choose to use a
national projection system

Global projection: if your study area covers multiple countries, you can choose for a
global projection, such as UTM

Unprojected: this is not preferred, but you can use latitude, longitude coordinates
(EPSG:4326).

e C(Create detailed maps (1:10,000) with a coordinate grid

e Print several copies of the map for different purposes:

O

Field map, with numbered locations that you want to sample. Digitize the locations
in a GIS based on your understanding of the area. It is better to digitize more
locations than you can visit, because many will not be accessible in the field.

Field map, where you note where you make a field observation, based on the
location you measured with the GPS and the grid printed around the map. Make
enough of these maps, because they will get dirty in the field. Always use a pencil to
write on the maps, because a ballpoint will not work with dust and humidity.

Neat map. This is a map with your observation point that you keep at home and that
you update every time you come back from the field.

In this exercise we are going to survey de Markt in Delft, the Netherlands.

» Open QGIS

> Use OSM Standard from the QuickMapServices plugin to find de Markt (Zoom in on the
Netherlands, find Delft, zoom in on de Markt).
If the plugin is not installed yet, you can do it by choosing from the menu Plugins - Manage
and Install Plugins... . Then look for the QuickMapServices plugin and install it.

Your screen should be similar to this:
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| Q. Type to locate (Ctrl+K)

1leg Coordinate|485142.0,6802344.3 W Scale|1:1.367

~| @ Magnifier[100%

| Rotation [0,0°

< £PSG:3857 )Q

| ¥ Render

> Note that the projection of the Map Canvas is EPSG: 3857. In this exercise we will use
UTM Zone 31 North/WGS 84. Use http://www.spatialreference.org to find the EPSG code

and write it down. You need this also for setting up the GPS.

» Change the on-the-fly projection to EPSG: 32631, by clicking on the EPSG code in the

lower right of the Map Canvas.

> Inthe dialogue that follows, select the EPSG: 32631 projection from the list (tip: use

Filter).
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! Project Properties | CRS

% Default Styles
“._ Identify Layers
[==1

BE= Data Sources

L2 g Re lations

Variables

y @ Macros

— Project Coordinate Reference System (CRS)

™ No projection (or unknown/non-Earth projection)

Fiter | C. 32631 a
Recently used coordinate reference systems

Coordinate Reference System Authority ID

WGS 84 / UTM zone 31N EP5G:32631

| ILI
Coordinate reference systems of the world [” Hide deprecated CRSs
Coordinate Reference System Authority ID

= [l Projected Coordinate Systems
- Universal Transverse Mercator (UTM)
B8 VWGS 84 [ UTM zone 31N

1

Selected CRS |WGS 84 [ UTM zone 31N

Extent: 0.00, 0.00, 6.00, 84.00
Proj4: +proj=utm +zone=31 +datum=WG584
+units=m +no_defs

— Datum transformations

™ sk for datum transformation if several are avaiable (defined in global setting)

#l =] /|

Source CRS | Source datum transform | Destination CRS | Destination daturn transform

’TI Cancel | Apply |

Help |

Now the correct EPSG code should be displayed in the lower right of the screen. Zoom in well on the

square using the magpnifier.

> Now from the QuickMapServices plugin choose the Google Satellite data to be displayed.
From the main menu choose: Web = QuickMapServices > Google = Google Satellite

h | R

eb Processing Help

Qais2threejs C t o] [T &= ||| R

€ 29

Q
P
97 N8 NG 1 Bing » |9
[

»
14 1[ n ESRI Wiries
-~ H Geofabrik » EWhiskies

iec) G v cooge Hybii

m Kosmosnimki.ru — # m Google Labels

I Landsat * E® Google Road 2
ﬁ MapSurfer NET 4
11. & Mapbox * ¥ Google Terrain
,!;éé @ NASA * E? Google Traffic
r}\ | “+ Georgia 4 I : Hﬂ"_’l?sn?"
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If you don’t see this option, you need to go to settings and install the contributed services
pack.

Make sure that the image is on top of the layers list or uncheck the OSM Standard layer.

= *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DEBRRR|[C2SPLARPPALBEERICE K- GEE* I =" D"

M@V A M) /B :rZG<iBo0~aA4Es%5% QAR 2 A -[B]+
|l ¥ Fm == Y
;rowser & X
LeY®e \
Favorites ij 8

& Home
3] c\
[} D:\
# z\

@ GeoPackage LJ f
Layers & X

« @ TVE&-FAO
= @ i Google li

'

%, § o . o 7
Q Type to locate (Ctri+K) 1leg Coordinate[593214.8,5763273.7 ¥ S5cale]1:860 ~| @ vagnifier[100% = Rotation [0,0° | ¥ Render @ EPSG:32631 @

» This image can be saved to a GeoTiff, so we can also use it offline. From the main menu
choose: Project = Import/Export - Export Map to Image...

i| Project Edit View Layer Settings Plugins Vector Raster Database Web
y
New Ctrl+N ;} @) p
PLPLPHEL
New from Template 4 r‘ P > =
& © f /il m =€
" Open... Ctr+0 d % &8 [ B
Open From » =] \r’ v
ol Open Recent 4
o
Close
A
[ save Ctr+s
[ save As_. Ctrl+Shift+S
Save To L4
Revert...
Properties. Ctrl+Shift+P
Snapping Options... b
Import/Export * =8 Export Map to Image... i
[Z) New Print Layout... Ctrl+P “m Export Map to PDF...
;J New Report... Export Project to DXF...
[4] Layout Manager... Import Layers from DWG/DXF...
Layouts v ‘ =
Exit QGIS ctrl+Q
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> Keep the Save Map as Image dialogue as default:

»! Save Map as Image

¥ Extent (current: map view)

Morth |5?632?9.426E|

West |593186.8634 East |593367.7380

South |5?63132.9061

Map view extent ‘ Draw on canvas

Calculate from layer -

Scale [1:860 =] 55|
Resolution |96 dpi :l
Output width 795 px =71
— W
Output height |ﬁ44 px :I 4

¥ Draw active decorations: none
¥ Draw annotations

¥ Save world file

Copy to clipboard Save Cancel | Help

> Make afolder D: \QGIS Exercises\Exercise 3 andsaveitas
Markt Delft UTM3IN.tif

» Start a new QGIS project and discard the current one by clicking D and click Discard in
the popup that will appear.
» Now add the raster layer Markt Delft UTM3IN.tif clicking the Open Data Source

Manager button % and then the choose Raster =~ == Choose the right projection when
the dialogue shows up. Note that this GeoTiff is georeferenced, but it does not contain the
projection. It only has a world file ( . t fw) that contains the coordinates. Therefore, the
projection needs to be indicated.

Now we are going to prepare your survey by digitizing points on the satellite image that you want
to visit in the field, e.g. buildings, statues, trees, etc. For now we only need to digitize Points and
give them an observation number. You can use this:

TO1, TO2, etc. for trees
S01, S02, etc. for statues
BO1, B02, etc. for buildings
RO1, RO2, etc. for streets

O O O O

Follow the steps below to do this:

» From the main menu select Layer -> Create Layer > New Shapefile Layer-...

»! *Untitled Project - QGIS

Project Edit View | Layer Settings Plugins Vector Raster Database Web Processing Help

0 E\S Data Source Manager ekl k DQQmmeae @

% @ \/,: Create Layer il < New GeoPackage Layer... CerShift+h
g e é Add Layer LV 1.c\, shapefie Layer...
0 E Embed Layers and Groups... ﬁ’ Hew Spatialite Layer...

Add from Layer Definttion File...
# New Temporary Scratch Layer...

¥ Prme Ghida T
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> In the dialogue, choose for the File name
D:\QGIS Exercises\Exercise 3\Planned observations.shp, selectthe
correct projection and create an attribute Obs Code with Text data as data type.

! New Shapefile Layer

File name b:‘\QGIS_E:(ercLses‘-lE:-cercEe_S\Phnned_nbsenGtiDns.shpI _I
File encoding IUTF-B j
Geometry type | Point -
™ Include Z dimension ™ Include M values
|EPSG:32631 - WGS 84 / UTM zone 31N = 2|
— New field
Mame |
Type |abe Text data ~|

Length IED Precision |

Add to fields list |

— Fields list
Mame Type Length Precision |
id Integer 10
Obs_code String 80

Remove field |
oK I Cancel | Help |

» Click Add to fields list
> Click OK

The new, empty, shapefile has now been added to your Layers panel.

> Selectthe Planned observations layerand click j to toggle editing

L
L ]
» Click the Add feature button ﬁ to start digitizing the points that we want to survey. Fill in
the attributes with the proper code.

» After digitizing toggle off editing by pressing f again and chose Save.
> Now style and label the points in such a way that they are clearly visible in the map.
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Browser F X

QTR0
Favorites &

[+ Home
[+ c\
) D:\
23] Z\

ﬁ: GeoPackage ~
Layers & X

¢ BeT &R AL
! Planned observations
¥ Markt_Delft_UTM31N

> Use the Print Composer to make a map with the points and a coordinate grid around. Export
the map to pdf and print the map on A3 format in colour and take it with you on the survey.

2 “Flieldmap

- o X
Layout Edt View Jrems AddItem Atls Settings
BREREBILeRELe @k ¢ (9icu®R
Rlaeil
TR e o T B oo 20 R e e e o oo e R 8 s o P e P2 e | o etomil
Items 8 x
© [@ [rtem
@ [ [T Projection: UTM Zone 31N,
M [ & Legend
@ O == <Sclebar>
@ O r~ <Picture>
@ [ [7) Field Map Survey Markt De..
M O [ Map1
Layout  Item Properties | Guides |
Ttem Properties ax
Map 1
v Main i =
Update preview |
Scale 673 =R
Map rotation [0,00 ° 18
s Use project CRS -] &
¥ Draw map canvas items
v Layers
I Folow map theme  [(none) LR =8
I™ Lock layers = e
™ Lock styles for layers
v Extents
Xmin [593.206,248 G
Y min [5.763.160,355 (=R
= X max [593.367,048 (=S o
1 item selected X: 256 mm y: 0 mm page: 1 80.4% =l sl

6.2.2 Observation forms
Depending on the purpose of your fieldwork, you need field observation forms. These can be forms

to observe land use, geomorphology, geology, household surveys, etc. Whatever form you need, it
always needs the following information:

e Observation number
o Name of the observer. This is important if you work in teams. Some observations are
subjective (e.g. visual estimation of vegetation cover) and it might be useful to relate it back

to the observer. This is also important if you need further information that is not covered
with the field forms.
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Date/time. This is very useful to link the observation to other time coded data, such as digital
photographs taken at the location, the GPS measurements or measurements from other
devices.

Coordinates (X, Y, Z). Always write down the coordinates that you measure with a GPS at the
observation location. The reason is that the device can get damaged or lost. Also you might
lose the data when you return the GPS to the laboratory where you borrowed it from.

You can print the field forms and make a strong booklet that you can take into the field or use a

notebook. Always fill in the forms with a pencil. Ballpoints don’t work with dust and humidity.

After each field day, copy your field form to a neat form or a database on your laptop. Always make a

backup and store it in the cloud or on a USB stick that you don’t take with you in the field.

>

6.2.3

Make a field form in your notebook for the survey of de Markt in Delft.

Preparation of the GPS

Before going into the field, please make sure that:

>

You have enough spare batteries to take with you

The GPS is complete with a USB cable

You have tested that the GPS works and connects to your laptop

Check GPS settings in the setup page. Check the time zone. The map projection and map
datum settings should correspond with the cartographic projection used on your field maps

Prepare the GPS with the guidelines above.

6.3 Surveying using a GPS
You are now ready to use the GPS for measuring your location in the field. Pay attention to the

following guidelines:

Wait marking your location into the GPS or writing down the coordinates until the handheld
GPS is receiving sufficient satellites with reasonable strength.

Apart from writing down in your field book the coordinates, write also down the EPE:
Estimated Point Error. It indicates how accurate the GPS reading is horizontally in meters.
Accurate GPS readings typically have EPE’s around 3-5 m.

Always use GPS and a together in the field. Always mark your position not only in the GPS or
in GPS coordinates but also on your field map and verify that you know where you are.

Be aware that satellite reception can sometimes be poor under a dense forest canopy, below
escarpments and in dense urban areas and hence position computation becomes less
accurate. Always check the EPE value.

The vertical height information (Z coordinate) of the GPS unit can have significantly higher
inaccuracy values and is therefore not trustworthy. For a detailed height measurement, more
Differential GPS (DGPS) systems or barometric altimeters should be used.
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For this exercise, choose an open area that you can use for practicing surveying, e.g. a park or a big
square. Try to find 3 types of objects:

e Points (e.g. trees, statues, wells)
e Llines (e.g. paths)
e Polygons (e.g. footprint of a house, terrace of café)

With most handheld GPS it is only possible to mark locations as waypoints. With the waypoints we
can store attributes. By default it has a Name and a Comment attribute. We will use the Name field
to give a unique code to each feature with a follow-up number. We will use the Comment field to
give a unique name to each specific object. This can then be used to convert the groups of waypoints
to features in QGIS using the Points to path tool form the Processing Toolbox.

The table below shows how this works:

Name | Note

TO1l Treel

T02 Tree2

TO3 Tree3 _

BO1 CityHall

802 C!tyHaII — These waypoints form one polygon
BO3 CityHall

B04 CityHall .

BO5 House

B06 House = These waypoints form one polygon
BO7 House

B08 House

RO1 Streetl | |

R0O2 Streetl These waypoints form one line

RO3 Streetl

RO4 Street2 These waypoints form one line

RO5 Street2

» Mark the waypoints of the objects:

e For points you only need 1 waypoint per feature. Give the waypoint a code for points,
e.g. TO1, SO1. Also give the feature a unique code in Comments, e.g. Treel, Statuel

e For lines you need multiple waypoints per feature and the number needs to be ordered,
e.g. RO1, RO2, RO3 are 3 points on the line in that order. Also give the feature a unique
code in Comments, e.g. Roadl, Road2 or the name of the street.

e For polygons you need multiple waypoints per feature and the number needs to be
ordered, e.g. BO1, BO2, B03. Also give the feature a unique code in Comments, e.g.
Cityhall, Church, etc.

> Fill in your field form for each feature.

6.4 Importing the GPS data into QGIS
> After getting back from the field, connect the GPS with a USB cable to the laptop.
» When the drivers are correctly installed, the computer will see the GPS as a USB disk. To

access the files choose from the main menu Vector 2 GPS = GPS Tools or use the
button (make sure the GPS Tools plugin is installed and/or activated).
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Vector Raster Database Web
—L Coordinate Capture
# Quick OSM L3 3
Geoprocessing Tools »
Geometry Tools 4
Analysis Tools L §
Data Management Tools *
Research Tools 4

ES GPS Tools
——TT——————

> In the dialogue choose the tab Load GPX file
> Browse to the GPS and choose the right GPX file from the GPX folder.

- — - — - -
O[\—)W| . » Computer » Garmin GRSMAP 64 (F:) » Garmin » GPX »

=)
Loy seamhax 9]
T TeSS————

.
/. Select GPX file

Organize * MNew folder =~ [ @
[ Documents “ MName Date modified Type Size |~
Musi -
él p_::lc 4 Waypoints_06-AUG-15.gpx 06/08/2015 9:15 OpenStreetMap d... 3KB
= ‘u’fd e i Waypoints_05-AUG-15.gpx 05/08/2015 16:18 OpenStreetMap d... 3KB =
e i Waypoints_28-JUL-15.gpx OpenStreetMap d... 4 KB
i Waypoints_15-JUL-15.gpx OpenStreetMap d... 5KB
. Computer — . X ;
] i Waypoints_14-1UL-15.gpx OpenStreetMap d... 5KB
5—" Windows (C:) 2
Data (DY) ik Waypoints_13-JUL-15.gpx OpenStreetMap d... 6 KB
lSJD‘ SIZE}I-TC E 3 * Waypoints_12-JUL-15.gpx OpenStreetMap d... 6 KB
o _( e £ 4 Waypoints_11-JUL-15.gpx OpenStreetMap d... 4 KB
A Garmin GPSMAP ” )
il (\vp-filesery =L Track_2015-07-11 081900.gpx OpenStreetMap d... 2KB
==l P . " Waypoints_02-JUN-15.gpx 02/06/2015 16:04 OpenStreetMap d... 2KB
&2 Software Library |- ¥ Wavnninte 1 -MAV-15 any 21 M55 17-54 OinenStresthlan d 2 KR 2
File name: | - ’GPS eXchange format (*.gpx) v]
[ Open ] ’ Cancel ]

h

-
7 GPS Tools -
: -

Load GPX file I Import other fle | Download fromGPS | Upload to GPS | GPX Conversions |

File I F: /Garmin/GPY M aypoints_06-ALG-15.gpx Browse... |

Feature types v Waypaints

[~ Routes
[T Tracks

Ok I Cancel Help

» Only check the box before Waypoints and click OK to import the data to QGIS

» From the attribute table select the point features and export them as a separate shape
file. Do the same for lines and polygons so you have 3 files, one for points, one for lines
and one for polygons.

» Open the Processing Toolbox panel from the menu: Processing = Toolbox
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Processing Help

£-1 Toolbox Ctri+Al+T

‘% Graphical Modeler_.  Ctri+Al+M
() History... Ctrl-+Alt+H
= Results Viewer Ctrl+Al+R

In the Processing Toolbox search Points to Path

Processing Toolbox 8 x
e A (D) D %y
| O points to path| a

- Recently used
¢ Points to path
= (2 Vector creation
3% Points to path

In the Points to Path dialogue choose the shapefile containing the points that should be
converted to lines. As Order field choose the observation number. For Group field you
use the Comments.

Repeat the same steps for the polygons

Evaluate the results.
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Exercise 4: Map Algebra
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7 Spatial planning using map algebra

7.1 Learning objectives
After this exercise you will be able to:

7.2

apply map algebra for raster analysis

distinguish Boolean, discrete and continuous rasters
make legends for Boolean, discrete and continuous maps
understand the use of Nodata

use logical operators

calculate distances

Introduction

The Department of Planning of the (imaginary) oasis Ain Kju Dzjis is planning to build the National

Institute for Oasis Management (NIOM) in their village. They came up with the following conditions

for building the complex:

O U WN B

No industry, mine or landfill within 300 meters of the new complex;
Not on locations presently in use for buildings, water or roads;

The slope should be less than or equal to 3%;

The distance from an existing road should be less than 500 meters;
The area should be contiguous;

The area should be greater than, or equal to 2 hectares.

They hired you as a GIS consultant to find the most appropriate locations. You will use map algebra

to perform the required multicriteria analysis.

7.3 Preparation

> Download the data for Exercise 4 from the OpenCourseWare website
(http://ocw.unesco-ihe.org/course/view.php?id=11) and store the files in a folder on your

harddrive (e.g. D: \QGIS Exercises\Exercise 4).

In this exercise you will use the following maps: buildg.tif, iswater.tif, isroad.tif,

topo.tif, roads.tif and areamask.shp.

First we are going to add the exercise folder to the Favorites in the Browser Panel.
» Click right on Favorites - Add a Directory...

) Untitled Project - QGIS

Project Edit Wiew Layer Settings Plugins WVeck

DEBRBREE)O %
LA AV

Browser

ORETHO

[adsDrecior.. |

> Click the + to collapse the contents of the folder.
> Preview the maps and metadata of these raster layers by clicking right on the layer file
Properties.
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Browser

LRETHO

=3 Favorites

= 5 Z:\QGIS_Exercises\Exercise_4
- G2 areamask.shp

Add Selected Layer(s) to Canvas

A coperies |
X Properties...
-

- roz

Delete File "buildg.tif”..

= topoEr
Lo i wells. B

The Layer properties window will open, showing the metadata of the layer:

»! Layer Properties

Information from provider

Name
Path
CRS
Extent

Unit

Width

Height

Data type

GDAL Driver
Description

GDAL Driver Metadata
Dataset Description
Compression

Band 1

More information
Dimensions
Origin

Pixel Size

buildg.tif

ZMAGIS Exercises\Exercise 4\buildg tif

EPSG:32630 - WGS5 84/ UTM zone 30N - Projected
288674.6709999599725916,3343810.1430000001364622 :
291674.6709999999729916,3352810.1430000001364622
meters

60

60

UlInt16 - Sixteen bit unsigned integer

GTiff

GeoTIFF
Z:/QGI5_Exercises/Exercise_d/buildg.tif

* STATISTICS_ MAXIMUM=5
* STATISTICS_MEAN=0.1991666666666T
* STATISTICS_MIMIMUM=0
*STATISTICS STDDEV=0.8638089905889
*AREA_OR_POINT=Area

X 60Y: 60 Bands: 1

288675,3.35281e+06

50,-50

Close

> Fill in the table:

Layer

File type

Number of
cells

Projection

Cell size

Minimum
value

Maximum

value

buildg

isroad

iswater

roads

topo

Areamask

» Select buildg.tif,iswater.tif,isroad.tif, topo.tif, roads.tif and
areamask. shp in the browser pannel. Keep the <ctr1> button pressed to select multiple

files. Then click right and choose Add Selected L

Browser

QRETHO

=-

Favorites

Properties...

-

Delete File "areamask.shp” ..

ayer(s) to Canvas.
g X
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» Go to the Layers panel and drag the areamask vector layer to the bottom.

Layers

o (@ ® T &, - O

=~ i buildg

B roads
=3 topo
areamask

Rasters normally only store values, so also in this case we need to assign a proper legend to the

maps. Let’s start with buildg.tif.

» Click right on the name of the layer and choose Properties.

VY VY

Click Classify

YV V

Click on the Symbology icon on the left @I
Under Render type choose: Paletted/Unique values

Keep Random as color ramp type and click OK

Now use the screenshot below to add the labels to the class numbers. Double click on the label

name to do this. Double click on the colour to make it more intuitive like the example.

» Layer Properties - buildg | Symbolegy

Ff Information
:{:\1_- Source

d Symbology

lﬂ Transparency
Histogram

7 )
&, Rendering
‘ Pyramids

E Metadata
-

Legend

QGIS Server

w Band Rendering

Render type |Pa|etted,"Unique valuas ;l

Band [Band 1 (Gray)
Color ramp Random colors
Value I Color | Label
| MNaone
1 . House
2 . Public building
3 . Landfil
4 . Industry
-] . Mine

Classify | ®] =| Delete Al I
‘| | LILI
Style 'l oK | Cancel | Apply | Help |

> Click OK to close the dialogue and look at the result. Is buildg a Boolean, discrete or

continuous map?

We have now learned that for discrete rasters we use the Paletted/Unique values render type.
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7.4 Using the Processing Toolbox
The Processing Toolbox in QGIS provides a lot of tools for processing GIS data. Besides QGIS tools, it
also has tools from GDAL, GRASS and SAGA that are very useful.

> First activate the Processing toolbox by choosing from the menu Processing = Toolbox

Project Edit Wiew Layer Setfings Plugins Vector Raster Database Web | Progessing Help

IDEBRRRH|[OS L0510 [ EEEEEE

— P — ¥ Graphical Modeler... Ctrl+Af+M
H{g @ {VS /% L) H v/ BRIZ-F T8 (O History... Ctri+Al-+H

Browser & = Results Viewer Ctri+AlE+R

First we are going to change a default setting of QGIS. The processing toolbox by default doesn’t use
the file name of the output as a layer name, which can be confusing.

> In the main menu choose Settings = Options = Processing.
» Collapse the General menu by clicking on the plus sign. Then check the box at Use filename as
layer name:

= Options | Processing

Setting Value
\‘..__ General ] # General
Default output raster layer extension tif
-3\:\\ System Default output vector layer extension apkg
' Invalid features filtering Stop algorithm execution when a geometry is invalid
4% Keep dilog open after running an algorthm
— Qutput folder C:\Users\hansa\AppData\RoamingQGIS\QGIS3\profies\default\processingloutputs
B8 Data Sources - 4% Post-execution script
7 Pre-execution script
& Rendering - 4% Show layer CRS definttion in selection boxes =]
Canvas & Legend Show tooltip when there are disabled providers
- - 3% Style for line layers
B® map Tools Style for point layers
- 3% Style for polygon layers
ﬁ Colors Style for raster layers
- 3§
ﬂ Digitzing 4% Warn before executing if parameter CRS's do not match
ﬂ s - == Menus Reset to dehultsl
¥ Models
‘5 GDAL [ 45 Providers
w- @ Scripts
Variables
a Authentication
—T. Network
Locator
A Advanced
Acceleration
*- Processing 0K I Cancel Help

» Click OK to close the dialogue.

7.5 Condition 1: No industry, mine or landfill within 300 meters of the new

complex
For condition 1 we have to create a grid with only mines, industry and landfills. Then we have to
calculate the Euclidean distance to these cells. Let’s start with creating a Boolean grid with only
mines, industry and landfills. The sections below will guide you through the steps.

7.5.1 Create a Boolean grid with True for industry, mine and landfill, and False for other
buildings
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» Choose in the processing toolbox
SAGA - Raster tools = Reclassify values (simple).

Processing Toolbox g X
BAOB| TN

Q. Search...

- () Vector overlay |

- () Vector selection
¥ (@ Vector table

i GDAL

- @ GRASS

- & SAGA

- 5plit RGB bands

Climate tools
Georeferencing
Geostatistics
Image analysis

[=1- Raster tools
- & Agaregate
& Average with mask 1
- & Average with mask 2
- & Average with thereshold 1
- & Average with thereshold 2
- & Average with thereshold 3
& Change data storage
& Close gaps
- & Close gaps with spline
- & Close gaps with stepwise resampling
& Close one cell gaps
& Constant grid
- & Convert data storage type
- & Crop to data
- & Destriping
& Destriping with mask
& Directional average
- & Invert data/no-data
- & Invert grid
- & Mirror grid
& Mosaic raster kyers
- & Patching
- & Proximity raster
- & Raster buffer
& Raster cell index
& Raster masking
- & Raster orientation
- & Raster proximity buffer
- & Reclassfy values

- & Resampling

» The Reclassify values (simple) dialogue appears. We are going to reclassify the buildg raster
using a lookup table. Fill in the dialogue exactly as follows:

. Reclassify Values (Simple)

Parameters | Log I
Grid

Ii buildg [EPSG:32630] ~| ]

Replace Condition

I[U] Grid value equals low value j
Lookup Table
IFixed table 3x3 _I
Changed Grid
ID:IQGIS_Exerdses;’Exerdse_‘&ﬁndust’y.sdat _I

¥ Open output file after running algorithm

| 0% Cancel |
Run as Batch Process. .. | Run I Close | Help |




o Then go to Lookup table and click :]

o Fill'it like the table below. Note that don’t change the second column (High Value),

because the Replace Condition is set to [0] Grid value equals low value. We can use the
second column if we want to reclassify ranges of pixel values.

» Fixed table
Low Value | High Value | Replace with | Add row |
0 0 0 Remove row(s)
1 0 0 Remaove all
0 ! Cancel
4 0 1

1
2|
3|
43
5|
o

o Click OK and Run. Close the dialogue.

» Check the result: 1 for mines, industry and landfills, 0 for the other classes. Use the Identify tool

and click on the map. On the panel down right you can find the identify results. It displays

the value of the pixel of the selected layer in the Layers panel. You might have to resize the

columns to see the pixel values.

ldentify Results g x

=8 _f =8 B uﬂ, -
Feature Value
=0 buildg

= buildg

Band 1 5
=+ (Derived)}

Mode |Current layer hd [” Auto open form
View | Tree - Help

» Is industry a Boolean, discrete or continuous raster?

» Is the legend that QGIS has assigned automatically correct? Give the industry layer a nice

legend, similar as you did for the buildg layer.

7.5.2 Calculate the Euclidean distance to industry cells

» Select from the menu Raster = Analysis = Proximity (Raster Distance)....
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\4

Project Edit View Layer Settings Plugins Vector | Raster Database Progcessing Help

IDEBRBRRK|O P e DLAEBII|@s WS- LHE#EE ¢

Align Rasters...

co @ N
|B@V.Z W p 5 T . EE IR
Browser Projections Y Fil nodata...
LT O Miscelaneous * B 6rid (Moving Average)..
P —— E’;’::::;‘" : [ Grid (Data Metrics)..
1= 5 Z:\QGIS_Exercises\Exercise_4 — h’, Grid (Inverse Distance to a Power)..
2 areamask.shp . Grid (Nearest Neighbor)..
& buidg.tt u Mishade..
(@ Exerdse_4 W
5 industry.sdat I ! Near Black .
= isroad.tif [\ Proximity (Raster Distance).
= iswater.tf % Roughness...
# roads.tf Wl Sieve..
= topo.tif s
= wels.f 1 e
[ [® Project Home i Topographic Posttion Index (TPI)..
- [@ Home % Terrain Ruggedness Index (TRI)...
R
-] s\
R =
B[] Z\
(’,‘ GeoPackage LI
Layers 8 x
o il ® T &~ 0
=58 ] industry
- . No industry
- I Industry

Fill in the Proximity (Raster distance) dialogue as in the screenshot:
o Make sure the Input layer is industry
o Because our raster layer
consists of only one

/ (Raster Distance)

Parameters | Log |

band we keep Band Input layer =
number as Band 1. [+ industry [EPSG:32630] M
. Band number
o Choose for Distance [Band 1 B

units Georeferenced A list of pixel values in the source image to be considered target pixels [optional]

Distance units

coordinates. In this

way the distances are | Georeferenced coordinates R
| | t d . t The maximum distance to be generated [optional]
Calculated In meters. [0.000000 e
o We don’t choose a Value to be applied to all pixels that are within the -maxdist of target pixels [optional]
maximum distance. The lo.os0000 a3
Nodata value to use for the destination proximity raster [optional]
default 0 means that [0.000000 =3
there’s no maximum. Bty
[Float32 El
o By default the Nodata » Advanced parameters
value to use fOf the Additional creation options [optional]
. . .. Profile |Default i
destination proximity e Dero F
MName Value |

raster is set to 0. This

means that the distances
il El Validate Help

Proximity map

|D:/QG]S_Exercisestxercise_4jinddist.tif _I

zero cells. ¥ Open output file after running algorithm

GDAL/OGR console call

L. gdal_proximity.bat -srcband 1 -distunits GEO -nodata 0.0 -ot Float32 -of GTiff Z:/
Proximi ty map QGIS_Exercises/Exercise_4/industry.sdat D:/QGIS_Exerdises/Exercise_4/inddist.tif -

inddist.tif.
| 0% Cancel

Click Run and Close.
Run as Batch Process... Run Close | Help |

Check the result. Is the inddist
layer a Boolean, discrete or continuous raster? Make a legend that is appropriate for this raster

will be calculated from

all zero cells to the non-

o Name the output

type using Singleband pseudocolor as render type. Use intuitive colours.
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7.5.3 Create a Boolean map with True for cells further than 300 meters from industry
and False for other cells
Now we need a map with all the pixels further than 300 meters from mines, industry and
landfills. In the Menu select Raster - Raster calculator... .

Project Edit Wiew Layer Settings Plugins Vector | Raster Database Progessing Help
IDNEBRmEY|| D& EEEEED ¢ Qe - U -G EE¥ I =

M@V AMII ) Bt e Boel=wmu=wnseln]

Browser Projections

3

3

o~ s Miscellaneous 4
OE2TH0 .
3

Extraction
Conversion

b5t Favorites

= 9 Z:\QGIS_Exercises\Exarcise_4
-0 areamask.shp

- i buildg.tf

- (3 Exercise_4

- i industry.sdat

™ isroad.tif

¥ iswater.tif

LW roads.tf

o topo.tf

- wells.tif

[+ [% Project Home

- [&] Home

CERE

B[ D\

£

£

i [ E\
i [] Z:\
- & GeoPackage ;I

Layers &2 X

o §®TE RO
Mo

o M 2305

> Double clickon inddist@1 (@1 means first layer of a stack, but our maps are single layers so
all have only @1), click on the >= button and type 300. Call the output layer noind.tif. The
dialogue should resemble the figure below.

= Raster Calculator

—Raster Bands - — Result Layer

buildg@1 Qutput layer |D:\QGIS_ExercLses‘\ExercLse_4\noind.t'rF a |

inddist@1

industry@1 Output format | GeoTTFF x|

isroad@1

iswater@l Selected Layer Extentl

roads@1

topo@1 Xmin |288674.67100 = X Max |291674.67100 =
¥min [3349810.14300 = ¥ max [3352810.14300 =
Columns |60 = Rows |60 =
Output CRS |EPSG:32630 - WGS 84 / UTM zone 30N =1 &l
v Add result to project

¥ Operators

—Raster Calculator Expression

"inddist@l" »= 300

Expression valid

oK | Cancel | Help |

» Click OK and view the resulting grid for condition 1. Is the result of condition 1 (noind) Boolean,
discrete or continuous? Give the right legend.
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7.6 Condition 2: Not on locations presently in use for buildings, water or

roads

For condition 2 we have to select pixels without buildings, water or roads.

»

First we produce a Boolean grid with value 1 for locations without buildings. Use the Raster
calculator to do this: "buildg@1™ = 0. This results in Boolean true (1) for locations without
building and false (0) for locations with buildings. Call this map nobuild.

With the raster calculator we search for which pixels have no water and no roads. The pixels
without water can be calculated by the following expression: "iswater@1l" = 0
Call this map nowater.

Do the same for pixels without roads (use the i sroad layer). Call it noroad. Check the results.

Are nobuild, nowater and noroad Boolean, discrete or continuous rasters? Give the right
legend to these layers.

7.7 Condition 3: The slope should be less than or equal to 3%

For condition 3 we have to calculate the slope from the topo grid, which contains elevation
values.

From the Menu choose: Raster - Analysis - Slope...

Project Edit View Layer Seftings Plugins Vector | Raster Database Progessing Help

IDEBRME Y| M @ % Rt lastor. R)ﬂéﬁ@@@@‘ﬂ@’@;ﬁiﬁ' -5, ErEl"

Align Rasters...

i °0 @
LLAVAINAERY - P ek RAENT 1
Browser Projections * i Fil nodata..
LRATHO Miscelaneous * | crid (Moving Average)
=+~ Favorites ?;::::;?ﬂnn ' & Grid (Data Metrics)...
= B Z:\QGIS_Exercises\Exercise_4 L i’, Grid (Inverse Distance to a Power)..
-+ 0 areamask.shp l', Grid (Mearest Neighbor)..
" @ Exercse_4 & Hilshade
B industry.sdat I'I Nezr Black...
W isroad.tf " Proximity (Raster Distance)...
= iswater.tf 4 Roughness...
i roads.of Wy Sieve
R o
L wells.tF 4] Slope...
[ [ Project Home 7 Topographic Position Index (TPI)...
- [ Home 4w Terain Ruggedness Index (TRI)..
=7 cy B |
=[] D
B[] BN
B[] 2N
- @ GeoPackage ;I
Layers g X
o il ® T &~ @0
= [ ¥ noroad =
il Road
B vo road
B ¥ nowater
-l water
[ o water
= ¥ nobuild
Buildings
. Mo buildings
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» Fill in the dialogue like below. Don't forget to choose topo as the DEM Raster, check the box

before Compute edges, choose for Mode Slope and choose Slope expressed as percent (instead of
as degrees). Keep the algorithm as default, call the output slopemap.tif.
Why do we need to compute the edges?

Does this algorithm work with unprojected (lat/lon) coordinates?

» Click Run, Close

» Check the result. Is slopemap a Boolean, discrete or continuous raster? Give the right legend.

Parameters l Log ]

Input layer

¥ topo [EPSG:32630] E
Band number

Band 1 (Gray) |
Ratio of vertical units to horizontal

11.000000 =

I Slope expressed as percent instead of degrees
W Compute edges
[ Use ZevenbergenThorne formula instead of the Horn's one
¥ Advanced parameters
Additional creation options [optional]
Profile |Default R

MName | Value |

Eﬂ Validate| Help ‘

Slope
|D:/QGIS_Exercises,fExercise_ﬁr!slopemap.tif J

W Open output file after running algorithm
GDAL/OGR console call
gdaldem slope Z:/QGIS_Exercises/Exercise_4/topo.tif D:/

QGIS_Exercises/Exercise_4/slopemap.tif -of GTiff -b 1 -s
1.0 -p -compute_edges

0% Cancel

Run as Batch Pmcess...| Run Close | Help ‘

» Inorder to select the slopes less than or equal to 3% use the Raster Calculator

("slopemap@l" <= 3).Callthe output map nosteep. Is nosteep a Boolean, discrete or

continuous raster? Give the right legend.
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7.8 Condition 4: The distance from an existing road should be less than

500 meters

Let’s first describe what we should do, before we perform the GIS analysis. The steps will follow.
Like condition 1, this condition is met by applying the following steps:
1) Creation of a Boolean map with True for tarmac roads and False for other cells
2) Calculation of Euclidean distance from all cells to these roads by:
a. Calculating the Euclidean distance
b. Creating a Boolean map with True for cells < 500 m from these roads and False for
cells 2 500 m from these roads.

First we have to select all the tarmac roads. The table below shows the legend of the roads map.
» Make the legend in the same way as we did for buildg before. Use this table:

0 | Noroads

1 | Dirtroad

2 | Tarmac road

> In this case use the Raster calculator to assign Boolean True (1) for tarmac roads and False (0) for
the rest of the map. Call the map tarmacroad. Check the result. Assign the right legend.

> Now calculate the distance to a tarmac road like you did before (Raster > Analysis > Proximity
(Raster Distance)...). Call the resulting map tardist. Check the result. Assign the right colours
to the legend

> To create a grid with only pixels within a distance of 500 meters from tarmac roads, use the
Raster Calculator. The equation should be "tardist@1" < 500. Check the result. Name it
tarzon. Assign the right colours to the legend.

7.9 Combine criteria 1 to 4

» Now all the new maps should be combined to create a grid, which satisfies condition 1 to 4. So all
pixels with value 1 (True) innoind, nobuild, nowater, noroad, nosteepand
tarzon should be selected. Use the Raster Calculator. The dialogue should resemble the figure
below.

» Raster Calculator

Raster Bands Result Layer
induztrv@l j Output layer Exercwses\Exercise_‘%\ninmgn.t'rf a J
isroad@1
Ewater@l Output format |GeuTIFF j
nobuild @1
noind@1 Selected Layer Extent
noroad@1
nosteep@1 Xmn [288674.67100 =] X Max [291674.67100 =
nowater@1l
roads@1 Ymin [3349810.14300 - Y mex [3352810.14300 -
I @l
gr%ie;tngq Colurmns |60 - Rows |60 =
ta d@l %
rmaciua g Output CRS |EPSG:32620 - WGS 84 / UTM zor = | j
topo@1 z v Add result to project
¥ Operators
+ | & | sqrt | cos | sin | tan | log1o | ( ‘
| ! | £ | acos | asin | atan | In | ) ‘
P D D D P e T

Raster Calculator Expression

"noind@l™ BND "nobuild@l™ AND "nowaterfl™ END "norcad@l™ AND "nosteep@l™ AND "tarzon@l™

Expression valid

oK Cancel | Help |

» Call the resulting map niomgo and click OK. Check the result carefully and give it the right
legend.
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7.10 Condition 5: The area should be contiguous
To satisfy condition 5 the groups of pixels must be clustered and then they will get a unique group

number. Then the area must then be calculated for each group. Because Zero values also form a

cluster we need to first change them to nod

ata.

> We can use the clipper tool to change 0 values to nodata in niomgo. In the main menu choose
Raster - Extraction = Clip Raster by Extent...

Project Edit View Layer Settings Plugins Vector | Raster Database Processing Help

” B = 8 ”@ b % Rester Cakuitor...
Align Rasters...

| R@V A MY ) BEP s

Browser Projections

ARTRTO Miscellaneous

= 5'r Favorites
B 5 Z:\QGIS_Exercises\Exercise_4

(2 areamask.shp
- B buidg.tif
(D Exercise_4
= industry.sdat
I isroad.tf
- B iswater.tif
o B roads.tif
= topo.tif
B wels.tf

+ [ % Project Home

- [¢1] Home

s c\

Ho [ D

i [] E\

d [ 2\

- " GeoPackage

Layers

[o (B ® T &~ 5 B L

Conversion

[
[+
[E
[
[
[+

DRAGED e & -%-

"REE ¥ I =

B

bc| <abcl <abc)

J=wE=s%s=aln)

3
»
3

Ll Clip Raster by Extent...

» ™ Cip Raster by Mask Layer...

(@ Contour..

= ¥ niomgo
B not suitable
-l sutable
B = tarzon
- [ Far from tarmac
B close to tarmac

» At Clipping extent click on the

will copy the extent of niomgo.

-

button, choose Layer extent and choose niomgo. It

» At Assign a specified nodata value to output bands type 0. In this way we make all zeros nodata.

» Name the result isniomgo.
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>

»! Clip Raster by Extent

Parameters | Log |
Input layer

| ¥ niomgo [EPSG:32630]
Clipping extent (xmin, xmax, ymin, ymax)

|288674.67 1,291674.671,3349810.143,3352810.143 [EPSG:32630] _l

Assign a specified nodata value to output bands [optional]

|0.000000

¥ Advanced parameters

Additional creation options [optional]

Profile | Default

MName |

Value |

ilil Validatel Help |

Output data type

|Use input layer data type

-

Le

Clipped (extent)

| D:/QGIS_Exercises/Exercise_4/isniomgo.tif
 Open output file after running algorithm
GDAL/OGR console call

N

gdal_translate -projwin 288674.671 3352810.143 291674.671 3349810.143 -a_nodata
0.0 -of GTiff Z:/QGIS_Exercises/Exercise_4/niomgo.tif D:/QGIS_Exercises/Exercise_4/

isniomgo.tif

Run as Batch Process...

0% Cancel |

Run Close | Help |

Click Run and Close the dialogue after running.

The method in GIS to give unique values to each cluster of pixels is called clump.

>

In the toolbox click on the r.clump tool (Grass - Raster = r.clump).
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Processing Toolbox

Qe vy

3

Q,

#- () Vector overlay
() Vector selection

- Imagery (i.*)
- Miscellaneous (m.*}
[=I- Raster (r.*)
- ¢ r.basins.fill
- g r.blend.combine
- @ r.blend.rgh
- 4@ r.buffer
- @ r.buffer.lowmem
- g r.anve
- @ r.category
- g r.category.out

-~ @ r.crcle

r.clump

» Fillin the dialogue that opens as below. Choose isniomgo as Input layer, call the output layer

>
>

niomgoclu.tif

! r.clump

Parameters I Log |
Input layer

I'isniomgo [EPSG: 32630]
Title for output raster map

Fl—

niomgocdu

¥ Advanced parameters

- Clump also diagonal cells
GRASS GIS 7 region extent (xmin, xmax, ymin, ymax) [optional]

|[Lea'-.-'e blank to use min covering extent]
GRASS GIS 7 region cellsize (Jeave 0 for default)

|0,000000
Qutput Rasters format options (createopt) [optional]

Qutput Rasters format metadata options (metaopt) [optional]

Clumps

|D : [QGI5_Exercises /Exercise_4/niomgodu. tif

v Open output file after running algorithm

r.clump

Recategorizes data in a raster map by grouping
cells that form physically discrete areas into unigue
categories,

Run as Batch Process... |

0% Cancel |

Run Close | Help |

Click Run and Close the dialogue when ready.
Inspect the result? Is the automatically assigned legend okay? Is niomgoclu a Boolean, discrete
or continuous layer? Assign the correct legend.
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7.11 Condition 6: The area should be greater than, or equal to 2 hectares

Finally, areas greater than 2 hectares can be calculated to satisfy the last condition.
For this last step we have to convert our raster to vector.
1. Inthe menu choose:

Raster = Conversion > Polygonize (Raster to Vector)...

Project Edit View Layer Setfings Plugins Vector | Raster Database Processing Help

[NECEIREY S
m@V.zmg /Bt

Browser
OET®TO

=- ¢ Favorites

2 areamask.shp
buildg.tif
@) Exercise_4
=" industry.sdat
= isroad.tif

JJ @ E:’" }ﬁ Raster Calculator...

Align Rasters...
Analysis
Projections
Miscellaneous
Extraction

4
4
3
4

- Conversion r =
= 5 Z:\QGIS_Exercises\Exercise_4 E

PrirBrges-

R—
7

W -
A

B =« E =3

abe| <abe

=

PCT to RGB..

& Polygonize (Raster to Vector)...
" Rasterize (Vector to Raster)...
%5 RGB to PCT_.

%, Translate (Convert Format)...

= iswater.tif
™ roads.tif
=" topo.tif
o B wels.tif
+ [% Project Home

H- [¢r] Home

H- [ €\

g [ D:\ I
i [ Es\

i [] Z:\

"' GeoPackage 1

I

B e e B R

Layers g X u

o« il ® T &~ L

-- " niomgociu -
S8 [

isniomgo

M niot suitable

» Fill in the dialogue as below. Call the output shapefile niompoly. shp. Note that the default
vector format is GeoPackage, so make sure you choose shapefile!

! Polygonize (Raster to Vector)

Parameters I Log |

Input layer
I' niomgodu [EPSG:32630]

Band number

IBand 1 (Palette)
MName of the field to create

Idump

™ Use 8-connectedness
Vectorized

ID:fQGIS_Exerdsestxerdse_4,.’niompoly. shp |

" Open output file after running algorithm
GDAL/OGR console call

gdal_polygonize.bat Z:/QGIS_Exercises/Exercise _4/niomaodu. tif D:f
QGIS_ExerdsesExerdse_4/niompoly.shp -b 1 -f "ESRI Shapefile™ None dump

0% Cancel |

Close |

Run as Batch Process... | Run in Background I

Help |




» Click Run and Close to return to the map canvas where the vector layer is displayed.
> Change the vector style of the niompoly layer so it matches with its contents:

» Layer Properties - niompoly | Symbology

I_E Categorized j

(4 information Colurmn {123 clump -] £

;,‘&1. Source Symbol [ change... |

Colar ramp Random colors |"|

Symbol |‘u’a|ue Legend IL
Labels =
& |

Diagrams

3D View

Source Fields

Attributes Form

(=T TN R« R I T
=T TN I = R IR IR N

—
L]
iy
(=]

Joins

-
(-
o
[ I

ﬁ Auxiliary Storage

Actions

—
(45 ]
-
[4%)

=
[= ]
=
[= ]

Display

—
wm o~
=
=N ]

' Rendering

._.
=5

-
=5

Variables

ra
g
[l
it

Metadata

REN
RN

Dependencies

NENEEEEENEEEENEERHEEENEEREE
J I T O
%

2 » k4
Classify | il il Delete Al | Advanced '|

P Layer Rendering

ﬂ[]ig'n:i::ing Style 'l oK | Cancel | Apply | Help |

In order to visualise the polygons larger than 2 ha, we have to do a selection based on this criterion.

Legend

erver

&
» Open the attribute layer of niompoly and click to open the dialogue for selection based
on an expression.

» Inthe dialogue go to Geometry and double click on $Sarea. Fill in the dialogue as given below
and click Select features.

63



=! Select by Expression - niompoly

Expression | Function Editor |
| | | | | | | | | ,l Q Search... function $ =
=1 +] - !r * | oA ” ( }r\m unciion jarea
-- Aggregates -~
Sarea >= 20000 - Arrays Returns the area of the current
B Color feature. The area calculated by
[+ Conditionals N )
B this function respects both the
&} Date and Time current project’s ellipsoid setting
[*- Fields and Values d it setti F
% Fuzzy Matching and area unit settings. For
B General example, if an ellipsoid has been
-EEOImety set for the project then the
- angle_at_wertex .
_ calculated area will be
- area ellipsoidal, and if no ellipsoid is
- azimuth .
- boundary set therj the :?alculated area will
- bounds be planimetric. L
- bounds_height
- bounds_width Sy ntax
- buffer
Output preview: 0 - buffer by m x| |$area hd
Help | &) Select features |'| Close |

The attribute table now shows 6 selected features. They are also highlighted in the map canvas,
giving the answer to the planning issue.

Export the selected polygons to a new shapefile:

» Click right on the niompoly layer name and choose Export - Save Selected Features As...

» Inthe dialogue, name the output file selectedlocations. shp and check the box before
Save only selected features.

>

o e

»! Save Vector Layer as...

Format IESRI Shapefile |

File name |D:\QGIS_Exerclses\Exerclse_4\5&|ectedlomtions.shp a |

Layer name |

CRS |EPSG:32630 - WGS 84 / UTM zone 30N =] &

Encoding |UTF~B |
¥ Save only selected features

v add saved file to map

P Select fields to export and their export options

¥ Geometry

Geometry type Automatic j
I™ Force multitype

I™ Indude z-dimension

P [ Extent (current: layer)
P Layer Options

P Custom Options

oK I Cancel Help

» Click OK.
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Now hide all layers and only show the selectedlocations layer. Give the layer the right
legend so we can see each location.

Try by yourself to add a column to the attribute table of the selectedlocations layerand
to calculate the areas of these locations.

Visualise the end result with a Google satellite image in the background. Use the
QuickMapServices plugin.

This whole exercise can be viewed in a screencast
at: https.//youtu.be/IfZSyBf6084
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8 Inaccessible wells

The Department of Planning of the Ain Kju Dzjis oasis has consulted you again to report to them
which wells in the oasis are inaccessible for the population. They consider wells that lie more than
150 meters from houses or roads as inaccessible. They provided you with a map with all the wells in
the oasis (wells.tif).

Try to solve this assignment on your own, using the map algebra skills of the previous section. The
result should be a raster layer with TRUE for the inaccessible wells and FALSE for the remaining area.
Besides wells.tif youshouldalsouse buildg.tif and isroad.tif. Make aflowchart of

the analysis.
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Exercise 5: Catchment delineation
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9 Catchment delineation

9.1

Introduction

In order to delineate a catchment from a DEM we need to follow these steps:

1)

2)
3)
4)
5)
6)

7)

8)
9)

Download the DEM tiles of your study area. Make sure that the tiles cover at least the study
area and that the catchment you want to derive is covered completely. Better to take it a bit
larger to avoid boundary effects

If your study area is covered by multiple DEM tiles, you need to mosaic (merge) the tiles to
create a single raster DEM layer

The DEM tiles might be in a different coordinate system then desired. In that case you have
to reproject the DEM layer to the projection you want to use in the study area

In the case that the merged tiles are much larger than your study area, you can subset (clip) it
to a smaller area to reduce calculation time

Make a hydrological correct DEM by filling sinks and removing spikes from the raw DEM
Calculate the flow direction for each cell

Calculate the flow accumulation for each cell: how many upstream cells contribute to the
runoff in each downstream cell of the DEM

Derive the drainage network

Calculate the catchment for the outflow point of the catchment

When a map with the stream network already exists, the procedure can be improved by "burning"

the river network into the DEM. In that way the DEM is always lower at rivers and runoff will follow

the actual river network. This is out of the scope of this exercise.

This flowchart below summarizes the procedure:

Download Mosaic DEM _
DEM tiles tiles Q Reproject DEM

v

Calculate the Sty
flow direction @ Subset DEM
map

remove spikes

. Define outflow Derive
Derive streams .
point

catchment
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9.2 Download the DEM tiles

For the Rur study area, we will use 4 tiles from the SRTM 1 Arc-Second global data set. The United
States Government announced on September 23 2014 that the highest possible resolution of global
topographic data derived from the SRTM mission will be released to public. Since the end of 2014 a
1-arc second global digital elevation model (30 meters) has been released. Most part of the world
has been covered by this dataset ranging from 54 degrees south to 60 degrees north latitude except
for the Middle East and North Africa area. A description of the SRTM data products can be found
here: https://Ita.cr.usgs.gov/SRTM1Arc.

For this exercise the tiles n50_e005_larc _v3.tif,n50_e006_larc_v3.tif,
n51 e005 larc v3.tifandn51 e006_larc_v3.tif were already downloaded and
provided. Save the data in e.g. D:\QGIS_Exercises\Exercise_5.

If you want to download data yourself, you can use the USGS EarthExplorer
(http://earthexplorer.usgs.gov).

[ Home 3 Hew System Messages Protie Save Criteria_Load Favorte ~ Manage Critria Logout pvdkwast EMEEE Feedback Help

searcn Citeria [Nl Adotional Criteria | Resuts Search Criteria Sussmary (Srow) Clear Criteria

2. Select Your Data Set(s)

Check the boxes for the data set(s) you want to search.
‘When done selecting data set(s), click the Additional
Criteria or Results buttons below. Click the plus sign
next to the category name to show a list of data sets

‘ Use Data Set Prefiter (wnats This?) ‘

Data Set Search ‘ e,

= Aerial Imagery
 AVHRR
¥ CallVal Reference Sites
 Commercial
 Declassified Data
= Digital Elevation L
1) I ASTER GLOBAL DEM
© 1 CoNED TBDEM
© [ GMTED2010
[1@ % GToPO30
© £ GTOPO30 HYDRO 1K
71 @) 16 IFS4R Alaska
= SRTM
)@ [ SRTM 1 Arc-Second Global
@ £ SRTM Non-Void Filled
© 8 SRTM Void Filled
© ] SRTM Water Body Data
 Digital Line Graphs
 Digital Maps L
PEO
# GEOGLAM
 Global Fiducials
 Global Forest Observations Initiative
 Global Land Survey - - purchase or

Google

Alternatively, you can use the SRTM Downloader plugin to download the tiles directly your map
canvas.

U stm
- -
BB e SRTM Downloader e
2 Not installed Downloads SRTM Tiles from NASA
Server

Plugin for download of SRTM Tiles from NASA

77 20 rating vote(s), 13763 downloads

Category Plugins
Tags python

Settings Moreinfo homepage bug tracker code
repository

Author Dr. Horst Duester Sourcepole AG
Installed version 1.1.2

Available version 1.1.3 -
il | ,
Upgrade al Uninstal plugn| Reinstal pugn |

cose | wep |
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9.3 Load the DEM tiles in QGIS
1) Start QGIS Desktop.

2) Use the Open Data Source Manager button| g .

3) Choose Raster and browse up to the folder containing the SRTM tiles (e.g.
D:\QGIS Exercises\Exercise 5).Holdthe<Ctrl> button and select the 4 tiles
(n50 €005 larc v3.tif, n50 e006 larc v3.tif,
n51 e005 larc v3.tifand n51 e006 larc v3.tif)by leftclicking on the tiles.
Click Open.

»! Open GDAL Supported Raster Datase

N » ThisPC » Data(Z:) » QGIS_Exercises » Exercise 5 v O Search Exercise_3 2

Organise v New folder =~ [ @

41 StudyProject_Sai ™
& Verzonden besta

3 This PC
_J 3D Objects

I Desktop n30_eD05_1arc w3  n50_eD06_larcwd n51_eD05_larc w3  n51_eD06_larc w3

Documents tif tif tif tif
* Downloads

J‘! Music

&=/ Pictures

m Videos

i Windows ()

= RECOVERY (D:)

= HP Port Rep (E:)

- Data ()
v

File name: | "n31_e006_1arc_v3.tif" "n30_e005_larc_v3.tif" "n30_e006_larc_v3.tif" "n51_eD05_larc_v3.tif" V| GeoTIFF (*.tif *tiff *TIF *TIFF) ~

» Data Source Manager | Raster

. Browser —Source type

- g Vector @ File ¢ Protocol: HTTP(S), cloud, etc.

[ Source

Delimited Text
L Raster Dataset(s) I\QGIS_Exer(l;es\Exerdl;e_S\nSl_eﬂﬂS_lar(_vE.t'rF" "Z:\QGIS_FExercises\Exercise_5\n51_e006_1larc_v3.tif" _

"d GeoPackage

77, svatalre
PostgreSQL
MSSQL
Oracle

)B2
+[E

Virtual Layer

Close Add Help
ArcGIS Map Server )

4) Click Add and Close.
5) You should be able to see this map in the Map Canvas (as shown below).
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3 *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
IDEBRERH|OSLPLANPPLA/EBENI|CEC H-E-GEE¥T =00
M@V Ay BRA-ZT =<8 B =aEHuNE%%% Q@R

Browser 8 x

JREY®O

Favorites &
= £ Z:\QGIS_Exercises\Exercise_4.
2 areamask.shp ?—
5 buidg.tF -
Q Exercie_4
# industry.sdat
B isroad.tf
W iswater.tf
¥ roads.tf
¥ topo.tif
¥ wels.tf
# 5] Home
B0
=0 b\
B0 e\
B0 z\
@ Geopackage
Layers &
“HeTE-RAL
= @ ¥ n51 e006 larc v3
[
205
= & ¥ n51_e005_1arc_v3
[ [BH
103
= B ¥ n50_e006_1arc_v3

i

705
= M ¥ n50_e005_1arc_v3

| F&

653

X Type to locate (Ctri+K) Coordinate|  6.953,52.006 % Scale[1:442356 ~| & Magnifier|100% E|i Rotation [0.0 ® =] © Render @ EpsGi4326 @

We see the four tiles in greyscale. We can distinguish the tiles, because QGIS automatically stretches
the grey values per tile. That means that the grey values are distributed according to the minimum and
maximum value of each tile. When we mosaic (merge) the tiles, QGIS will stretch the values for the
whole area, using the minimum and maximum value of the merged raster layer. You'll see that in the
next section.

9.4 Mosaic DEM tiles
Before we proceed, we have to merge the four DEM tiles, which in GIS terminology is called mosaic.
There are two ways to mosaic the tiles:

e Merge the tiles into one physical file
e Merge the tiles into a virtual file

The first option is slower. If we have many tiles, we prefer to make a virtual file that virtually merges
all the tiles. That will be done with the following steps:

1) Inthe menu choose Raster - Miscellaneous = Build Virtual Raster...

Project Edit View Layer Settings Plugins Vector | Raster Database Web Processing Help

H D _ E@ =$ m@@; }!,g Raster Calculator... [ ) }a ) [E [[E [EI e |

Align Rasters...

[ R@V M1 ) BRE e |B = %=

Browser Projections Pk
i v I Gid vi
AR TTO CEIEGUE } Build Virtual Raster...
- raction :
=+ Favorites o g i.;- Raster Information...
= 5 Z:\QGIS_Exercises\Exercise_4 - Merge...

- (= areamask.shp &%, Buid Overviews (Pyramids)...

: ¥ buildg.tf B Tile Index...
i X Fxerrise 4 -
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2) Inthe Build Virtual Raster dialogue you can choose each file individually or merge all files in a

directory (folder). We can also merge the files that are visible in the Map Canvas. We use the

last option:

e At Input layers click J
Use the Select all button to select the four tiles and click OK.

<) Multiple selection

n30_e005_1arc_v3 [EP5G:4326]
n30_e006_larc_v3 [EP5G:4326]
n31_e005_larc_v3 [EP5G:4326]

n51_e006_larc_v3 [EP5G:4326]

Select all
Clear selection
Toggle selection

Add file(s)...

Cancel

dddild

browse to the location where you want to save the output file (e.g.

D:\QGIS Exercises\Exercise 5)and giveitthe name dem mosaic.vrt

Resolution is default set to average. In our case the files all have the same resolution

(1 Arc Second).

Uncheck the box before Place each input file into a separate band. This needs to be
checked only if you want to create a mapstack, i.e. with remote sensing bands.

Keep the Resampling algorithm at the default: nearest. This also has no impact,

because resampling is not needed.
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3)

The dialogue should now look like this:

! Build Virtual Raster

Parameters I Log]
Input layers

|4 elements selected

Resolution

|average -]
I Place each input file into a separate band

I Allow projection difference
¥ Advanced parameters

I Add alpha mask band to VRT when source raster has none
Override projection for the output file [optional]

Resampling algorithm

|nearest j
Virtual
|D:/QGIS_ExerciSes/Exercise_Sf’dem_mosaic.vrt J

¥ Open output file after running algorithm
GDAL/OGR console call

gdalbuildvrt -resolution average -r nearest -input_file_list C:/Users/hansa/AppData/
Local/Temp/processing_3898e6f6a87c4341beaB51eaa885db40\buildvrtinputFiles.txt
D:/QGIS_Exercises/Exercise_5/dem_mosaic.vrt

0% Cancel

Run as Batch Process... Run Close | Help |

Click Run to run the algorithm. Click Close to get back to the main screen where you can see
the merged DEM. You notice that in the Map Canvas the borders of the tiles are not visible
anymore in the merged DEM, because QGIS stretches the greyscale using the minimum and
maximum of the entire merged DEM. This is only for visualisation, the values in the tiles are
the same as in the mosaic.

Click right on the layer and choose Rename Layer. Rename the layer to dem mosaic.
Renaming is not needed anymore if you have changed the setting as described in Section 7.4.

Now remove the individual tiles (not the dem mosaic) from the layers list by selecting
them while the Ctrl button is pressed. Then clicking right one of the tile names and select
Remove Layer.... Click OK to confirm. This will remove the tiles from the screen, but not from
the hard disk.
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Layers

o il ® T &~ 0

= ] B dem_mosaic
-131
708
- n51 e006 larc }:‘_. Zoom to Layer
H s 0 Show in Overvi
o05 = Show in Overview
= n51_e005_1arc JEEREIET
12 Rename Layer
103 4 Zoom to Native Resolution (100%)
= n50_e006_1larc_ Stretch Using Current Extent
W2
L. 705 ] Duplicate Layer
= n50_e005_1larc B Rermove Layer...
-l 15
: 653 Move to Top
Group Selected

Set Layer Scale Visibility...
Set CRS

Export

Properties...

9.5 Reproject DEM

Before continuing, we need to know the projection of the DEM and reproject it to the projection of

our project.

1) Right click on the layer's name, and select Properties....

Layers
l@ wvv £ v_:,‘_:'u

| BES 42 Zoom to Layer
708

g x

o

U?, Show in Overview
Copy Layer
Rename Layer

}‘L‘i Zoom to Mative Resolution (100%)
Stretch Using Current Extent

L] Duplicate Layer
[l Remove Layer...

Set Layer Scale Visibility...
Set CRS

3

Export

3

Styles

3

T

2)

In the new window select Information (the top tab on the left hand-side of the new window).

3) Inthe Information window check the CRS (Coordinate reference system).
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Information from provider

Mame dem_mosaic
» Source Path ZI\QGIS Exercises\Exercise Sidem mosaicurt
’ CRS EP5G:4326 - WGS 84 - Geographic
Symbology Extent 4.9997222222222777 45.9938611111111089 :
TO00ZTTITIITITI78,52.0001383858888840
Transparency Unit  degrees
= Width 3601
Histogram Height 7201
Data type  Int16 - Sixteen bit signed integer
& * Rendering GDAL Dmﬂ.?r Description VRT
GDAL Driver Metadata Virtual Raster
) Dataset Description  Z:/QGIS_Exercises/Exercise_5/dem_mosaic.vrt
‘ Pyramids .
Compression
Band 1 * STATISTICS_APPROXIMATE=YES

!* Metadata

The DEM is in its original Lat/Lon Geographic Coordinate System with datum WGS 84 (EPSG: 4326).
We need to convert it into the projection of our project. Because the project covers multiple
countries, we will not use a local projection but a global projection: UTM Zone 32 North, with WGS-

Legend

Meore information

X 3601Y: 7201 Bands: 1
4.9%972,52.0001
0.000555556,-0.000277778

Dimensions
Origin
Pixel Size

Style v| oK |

Cancel |

® STATISTICS_MAXIMUM=T08

® STATISTICS_MEAN=168.64443907157
® STATISTICS_MINIMUM=-131

* STATISTICS_STDDEV=188.06635770914

Apply |

Help

84 as datum.

We can find the EPSG codes at http://www.spatialreference.org

n a browser:

4) Use the website to search for UTM 32N. You can leave QGIS opened and ope

| Home -- Spatial Reference

x\+

:.IEIQ

€3G

spatialreference.org c

Spatial Refi'_

Home | Upload Your Own | List user-contributed references | List all references

Find your references in any number of formats!

* See Existing EPSG Codes: 4326, 2805
* Upload your own Projection as WKT, proj4, etc.
* Browse a list:

© 4362 EPSG references

o 447 ESRI references

© 2380 IAU2000 references

© 2045 spatialreference.org references

Recently Viewed

® Perroud 1950 (deg), 480 views, 0 comments

e NAD8S3 / UTM zone 15N, 30708 views, 0 comments

» Albers Conical Equal Area as used by mrlc.gov (NLCD), 4264 views, 0 comments
& American Samoa 1962 / American Samoa Lambert, 2433 views, 0 comments

* WGS 84, 801270 views, 0 comments

Last update: 2013

wBe 9 3+ & O B & F ¢

utm 32N wgs 84

Recent Uploads

* SR-ORG:8549: CCL
INEGI

* SR-ORG:8548: dfd

* SR-ORG:8547: spot

* SR-ORG:8546: Test

* SR-ORG:8545:
CCTPrimary

-

m
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5) The database returns:

-

Spatial Reference List -- Spatial ... *

o~
o ':_ (' | (i) | spatialreference.org/ref/7search=u c | [ Q, Search
SN

Spatial Refe:-

Home | Upload Your Own | List user-contributed references | List all references utm 32N wgs 84 Search
Search References: utm 32N wgs 84 Search n
e EPSG:2215: Manoca 1962 / UTM zone 32N ||

* EPSG:3064: IGM95 / UTM zone 32N
* EPSG:3199: LGD2006 / UTM zone 32N

* SR-ORG:6860: UTM-WGS584 32N \
f * SR-ORG:6962: esri
fl * SR-ORG:7021: prova
L ® SR-ORG:7025: Dont know what it is I

® SR-ORG:7325: ETRS589 Zone32 Germany

* EPSG:7416: ETRS89 / UTM zone 32N + DVRS0 height
* SR-ORG:7444: WGS84 / UTM zone 32N

* SR-ORG:7887: ETRS89 / UTM zone 32N (zE-N)

* SR-ORG:7911: test

* SR-ORG:8076: prova

* SR-ORG:8089: WG5_1984_UTM_Zone_32N

* EPSG:32432: WGS 72BE / UTM zone 32N

* EPS5G:32632: WGS 84 / UTM zone 32N

About

We have to look at the EPSG codes. We will use the EPSG: 32632 throughout this project. If
you click on it you can see more details.

6) Now we are going to reproject the DEM from unprojected (Lat/Lon WGS 84 - EPSG: 4326) to
UTM Zone 32 North / WGS 84 (EPSG: 32632). From the main menu choose Raster =
Projections - Warp (Reproject)

» *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector | Raster Database Web Processing Help

U D = @ 14 M@Eﬂ’ }% Raster Calculator... D}a}a E U:g[l

P Align Rasters... —

Hﬂ@ ”aﬁaﬁ:“ﬁ.;—‘ﬂ b Analysis C "ﬁ@‘ b O
Browser Projections 8 ., Assign Projection...
LRATHO Miscellaneous LA \\/arp (Reproject)...
LA Extraction }

El 57 Favorites )

| ! Conversion 3

= 5 7ANGIS Frerrises\Fxarcise 4

7) Inthe Warp window, click @I to choose the Target CRS
8) In the dialogue that opens type 32632 at Filter and select WGS... EPSG: 32632 in the middle
of the dialogue window and click OK.
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9) NOW com plete the »! Coordinate Reference System Selector

dialogue: Define this layer's coordinate reference system:
This layer appears to have no projection specification. By default, this layer will now have its projection set to that

[ ] Resampling method to of the project, but you may override this by selecting a different projection below.

use: We choose Fiter | O 32632
R used coordi f st
Nearest ecently
. Coordinate Reference System Authority D
Neighbour to WGS 84 / UTM zone 32N EPSG:32632

preserve the elevation
values of the original

files. < [ 2]
e Setthe No data value Coordi fi stems of the world I” Hide deprecated CRSs
Coordinate Reference System Authority D
for output bands to - = {8 Projected Coordinate Systems
9 9 9 9 Because the = L?mversaf Transverse Mercator (UTM)

& WGS5 84 / UTM zone 32N EP5G:32632
raster layer will be
‘| | LI

Selected CRS IWGS 84/ UTM zone 32N

reprojected there will
Extent: 5,00, 0,00, 12,00, 84,00

be "no data" at the

borders. In thIS Way we i::g‘z:d:fpsmjwhn +zone=32 +datum="WG5584 +units=m
define that "no data"
has a value -9999 and

will not be visualised as

lldatall
) Parameters | Log |
e Setthe Output file Input layer B
resolution to 30 m. [ dem_mosaic [EPSG:4326] o ]
. Source CRS [optional]
o Browse to your exercise | 7 e
folder and name the Target CRS
output file [EPSG:32632 - WGS 84 / UTM zone 32N - 2|

. Resampling method to use
dem reprojected

[Nearest neighbour B

Nodata value for output bands [optional]

[-9999.000000 a3
Note the gda|Warp command that Qutput file resolution in target georeferenced units [optional ]

[30.000000 a3

will be executed in the background.

¥ Advanced parameters

. Additional creation options [optional]
10) Click Run to run the Profile [Defaut |

algorithm. After running
click Close to close the

window. | =| validate | Help |

Qutput data type
|Use input layer data type j
Georeferenced extents of output file to be created (xmin, xmax, ymin, ymax) [optional]

Name Value |

|:Lea\-'e blank to use min covering extent] _|
CRS of the target raster extent [optional]
! e

~ Use multithreaded warping implementation

Reprojected
|D:/QGIS_Exercises/Exercise_S/dEm_reprojected.tif _I
[riliay bt Bl o0 : 1 b i

‘ 0% Cancel
Run as Batch Process... Run Close | Help |

77




Now you will see that the re-projected DEM will appear in the list of Layers. The DEM may seem
distorted, as shown in the image below. This is due to the fact that the Map Canvas Projection is
still in Lat/Lon, as testified by the coordinates in the lower part of the Map Canvas. And the EPSG
code given in the lower right corner. This is due to the on-the-fly projection, which causes a
difference between the projection in the file and the one that is visualised.

Coordinate|4.604,50.122 % Sale|1:5943?8 'lﬁ Magn'rﬁerllt]t]% 3: Rotation I[],U" 3: ¥ Render é EPSG:432E-> Q
\_/

11) To complete this operation, and display properly the new dataset, we need to change the
on-the-fly projection of the Project. To do so click on the EPSG: 4326 in the lower right of the
screen.

12) In the new dialogue window select the EPSG:32632 projection that is already in the list of
Recently used coordinate reference systems, as shown below, and click OK.

! Project Properties | CRS

— Project Coordinate Reference System (CRS)
™ No projection (or unknown/non-Earth projection)
Fiter | . 32632 a

Recently used coordinate reference systems

Coordinate Reference System Authority ID

WGS 84 / UTM zone 32N EP5G:32632

""' Default Styles

Data Sources
4 »
Relations I | _I
Coordinate reference systems of the world " Hide deprecated CRSs
|I|r i ¥
I Coordinate Reference System |Author'rty D
Macros = m Projected Coordinate Systems
- = Umiversal Transverse Mercator (L1TM)
IE P “ WGES 84 [ UTM zone 32N EPSG:32632
QGIS Server
4| Iﬂ

Selected CRS |WGS 84 / UTM zone 32N

Extent: 6.00, 0.00, 12.00, 84.00
Proj4: +proj=utm +zone=32
+datum=WG584 +units=m +no_defs

— Datum Transformations

™ Ask for datum transformation if several are avaiable (defined in global setting)

#| =] /|

Source CRS | Source datum transform | Destination CRS | Destination datum tra

4| | LI

OK I Cancel | Apphy | Help |

In the Map Canvas the DEM is now displayed in the correct position (with the North pointing
up), as shown below. The coordinates of the new display are also in meters as we want.
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» *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

IDEBRRR[NPL2LAAPPLALABRINIAE -R-I-LEE¥ S & ¢ [0-
@V AW\ /B xZT =B B ["wEHu2%%% Q@R |28 ® B &

Browser & x

QY ®0
Favorites &
Home

+ z:\
@ GeoPackage

Layers &
R SR e
= @ @ Reprojected

[ BtH

700

=] . dem_mosaic

| Bk

708

- &
o
=

x |

[ Type to locate (Curi+K) 4 legend entries remov Coordinate [126184,5738163 ¥ Scale [1:1415300 ~| @ Magnfier[100% =] Rotation [0,0° = Vﬁier @Epsmz@

13) You can now remove the file dem mosaic

9.6 Subset DEM

In order to reduce the calculation time of the algorithms, we will subset (or clip) the raster layer.

An easy way to select the boundary of your study area (always make it a little bit bigger to prevent
boundary effects) is to use OpenStreetMap. OpenStreetMap contains crowd sourced data (see
http://www.openstreetmap.org for more info). If the QuickMapServices plugin is installed, you can
add an OpenStreetMap to QGIS as follows:

1) Inthe menu choose Web - QuickMapServices > OSM - OSM Standard
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Project Edit View Layer Settings Plugins Vector Raster Database | Web Progessing Help

IDoBRRE Y|

(0% 5505 O«

@V Z &4

|_ B - / D 0 D Ij

[

Browser

LRTHO

g X

2
E.

Favorites

5 Z:\QGIS_Exercises\Exercise_4
G2 areamask.shp

= buildg.tif

(2 Exercise_4

- B industry.sdat

- ¥ isroad.tif

= iswater.tif

- B roads.tif

- M topo.tf

e i wells.tif

[ D Home
R
- Diy
[
[+

1 [ E:\
|- [ Z3\
"' GeoPackage

Layers

MRS ERS- 3 Xul

BN |

2)

unchecking the box or dragging the OSM layer to the top.

3)

B

”a AutoMavi
I; Bing

& esri

& GeoQ
u Geofabrik

Google
Kosmosnimki.ru

Portugal

EeENQ

Landsat
MapSurfer. NET

=

Mapbox
NASA
Georgia
CarteDB
Rosreestr
OpenSezMap
Sputnik
Stamen
strava

UsGs
2o TianDiTu
" Genshtab
=% Ukraine Cadastre
£ Waze
9 VYandex
E Bergfex

eftlas Mos
S OSM 4

(£} Search QMS
3 Add to Search

HE&sBes @6

® O5M Cycle map
»# O5M Humanitarian

P& O5SM Standard

@ O5M TF Landscape

Now an OpenStreetMap will be shown in the Map Canvas. Temporarily hide the DEM by

In order to know the approximate extent of the Rur catchment, the exercise data contains a

shapefile with the sources and the mouth of the catchment. Open the vector layer

source mouth.shp

4)
below:

Now, from the Main Menu select Raster - Extraction - Clip Raster by Extent...

as shown

Project Edit View Layer

Sett

ings Plugins Vector

DB BE&E a7

’_ E:.. &( ¥ Raster Calculator...

LAY

|#./ 8-S

Align Rasters...

Anabysis
Browser Projections
Q B 4 E o ) Miscellaneous

= 5 QGIS_Exercises
- [ Exercise_1

- [ Exercise_2

L R T o AR SR |

Conversion

+ B L

TN

-

Raster Database Web Processing Help

DRl BIRS
I 1=
3 | f

Rl
SErReiinge ()

Pavil My

Clip Raster by Extent_.
™ (Clip Raster by Mask Layer...

(@ Contour...
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5) Inthe Clip Raster by Extent dialogue choose as Input layer dem reprojected. For Clipping

6)

7)

8)

9)

extent, click on _I and choose Select extent on canvas.

» Clip Raster by Btent

Parameters | Log |
Input layer

| #* dem_reprojected [EPSG:32632]

Clipping extent (xmin, xmax, ymin, ymax)

- hia
R ]

Assign a specified nodata value to output bands [optional]

b Sy 4 Mageringen (
Use Canvas Extent

Select Extent on Canvas

|Not set

Use Layer Extent...

¥ Advanced narameters

TT s

e

Draw a box on the map around the points from the source mouth layer.

all ) \y;ﬂeu o~ ,Li
-~ )

g

oy, 8 S
Give the ouput file the
name

{

dem subset.tif.Use

the _I button to browse

to the right location (e.g.
D:\QGIS_Exercises\

Exercise 5).

Click Run and Close the
dialogue when ready.

Parameters | Log |

Input layer

[ dem_reprojected [EPSG:32632] -l .
Clipping extent (xmin, xmax, ymin, ymax)
55.0?3451542}'6,55}'0}'15.6}'1823}'39,5683882.62903}'111 [EPSG:32632] J
Assign a specified nodata value to output bands [optional]

INot set =

¥ Advanced parameters

Additional creation options [optional]
Profile |Default -
MName |
. | o]
jl El Validate | Help
Output data type
|Use input layer data type j

Clipped (extent)
ID:}’ QGIS_Exercises/Exercise_5/dem_subset.tif

I+ Open output file after running algorithm
GDAL/OGR console call
gdal_translate -projwin 280321.8132797977 5683882.629037111

341365.07345154276 5570715.671823739 -of GTiff Z:/QGIS_Exercises/
Exercise_5/dem_reprojected.tif D:/QGIS_Exercises/Exercise_5/dem_subset.tif

0% Cancel |

Run as Batch Pml:ess...l Run Close | Help |

Now you can remove dem_reprojected from the layers list as we have done before for
other layers that are not longer needed.
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9.7 Fill sinks / remove spikes
Raw, unprocessed DEMs have artefacts such as depressions and peaks. These artefacts are a result of
the DEM acquisition process and need to be removed before a DEM can be used for hydrological

analysis, like catchment and stream delineation or hydrological modelling. There are several

algorithms for filling sinks. Here we will use the algorithm developed by Wang and Liu (2006), which

is faster than other algorithms and therefore works better with high resolution datasets.

1)

2)

We will use the QGIS Processing Toolbox. If you don't see the Processing Toolbox at the right

of your screen, you can enable it by choosing from the main menu Processing = Toolbox

2RPP

Raster Database Web | Processing Help

t-1 Toolbox Crl+Al+T

o Graphical Modeler... Cerl+AlE-+M
#£ I ¢ B (1) History... CriAl+H
= ,7 = Results Viewer Ctrl+Ak+R
In the Processing Toolbox use the Search... field to search for fi11 sinks
Processing Toolbox g X
# 2 (0 2 T,
| O fill sinks I
- & SAGA
=1~ Simulation

& Fill sinks (gm of esp)
—I- Terrain Analysis - Hydrology
& Fil sinks

3 Fill sinks (wang & liu)
& Fill sinks s (wang & liu)

3) Go to SAGA - Terrain Analysis - Hydrology = Fill sinks (wang & liu).

You see that there are more algorithms for filling sinks. Each has its own advantages and

disadvantages in terms of calculation time, memory usage and accuracy. For your own research

you need to make a decision based on the documentation of the algorithms or by analysing the

results of several algorithms.

4)

In the dialogue keep the defaults. Make
sure to select dem_ subset as the input
and definedem fill.sdat as the Filled

DEM. Always use the E] button and
Save to file... to browse to the right
location (e.g.

D:\QGIS Course\Exercise_ 5). We
only need the Filled DEM at this point, so
you can uncheck the boxes for opening the
output of Flow Directions and Watershed
Basins.

Click Run and Close when done.

Now remove dem_subset from the layers
list, because it is no longer needed.

«! Fill Sinks (Wang & Liu)

Parameters ] Log ]
DEM

| 5 dem_subset [EPSG:32632] - .

Minimum Slope [Degree]
|0.010000
Filed DEM

[]

= |

| D:/QGIS_Exercises/Exercise_5/dem_fill.sdat J
L]

L]

[+ Open output file after running algorithm
Flow Directions

|[Sa‘-.-'e to tempaorary fila]

™ Open output file after running algorithm
Watershed Basins

|[Sa'-.-'e to temporary file]

™ Open output file after running algorithm

0% Cancel
Run as Batch Process. . | Run Close | Help |




9.8 Calculate Strahler order and determine threshold for streams
Before we can derive the streams from the DEM, we need to determine what we consider streams.

For this purpose we use the Strahler order. The higher the order, the bigger the stream.

1)

2)

3)

4)

Search for Strahler inthe Processing Toolbox and select
SAGA - Terrain Analysis - Channels - Strahler order

Processing Toolbox g X
- NONSRIVERN

1 strahler &
=& SAGA

=l Terrain Analysis - Channels

----- & Strahler order

In the dialogue select the Filled DEM for the elevation. And use strahler.sdat asthe

output filename and click Run. Click Close when the algorithm is done.

w! Strahler Order

FParameters I Log I

Elevation

Ii Filled DEM [EPSG:32532] ~| ]
Strahler Order

|DkIQGIS_Exerdses.’Exerdse_SIsh’ahler.sdat _I

7 Open output file after running algorithm

| 0% Cancel |
Run as Batch Process... | Run I

Close | Help |

Check the result. What are the minimum and maximum values? Is the Strahler raster discreet
or continuous? Make a nice legend, where the highest Strahler orders are more blue so you

can clearer see what the rivers are.
Use the Raster
Calculator to create a

«! Raster Calculator

Boolean map with 1 for | [ RasterBands, Result Layer =
dem_fil@1 Qutput lyer |D:\QGIS_Exerc'Lses\Exerclse_4\5tmhler5.t'rf a
Strahler order >= 5 and strahler@1
Output format |GeoTIFF =]
0 for the other values. EE———
Call the output file Xmn [203113227 = X Max [34136132297 =]
strahler5.tif Ymn [5570732.05240 = Y max [5683802.05240 =
Columns |2D35 33 Rows |3??2 33
. Output CRS EPSG:32632 - WGS 84 / UTM zone 32N j —‘-;
Make a nice legend _ ! 2|
¥ Add result to project
where 1 is blue and O is
W Operators
transparent. Check the « | o | st | s | s | wm | eme | |
result with the rivers in — 0 - = = =0 121
OpenStreetMap. < | > | = | = | = | s= | am | o |
— Raster Calculator Expression
Repeat steps 4 and 5 "strahlerfl” >= 5
with different
threshold values and Expression valid
choose the best result. o | _cancel | wep |
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9.9 Calculate flow direction, channel network and catchments

Now with our corrected DEM and the threshold value (Strahler order) we can proceed to calculate
the flow direction, channel network and catchments in our area. We will use the D8 method for flow
direction. The D8 method evaluates the slopes in 8 discrete directions around a pixel.

In the Processing Toolbox you can also find related tools that use different algorithms. Always check
the documentation of the algorithm to find the right one or do a comparative analysis.

1) Searchfor Channel inthe Processing Toolbox and select
SAGA - Terrain Analysis - Channels > Channel network and drainage basins

Processing Toolbox

*‘l ':v =l ..t.:.

g x

| O channel

- 4 GRASS
= Imagery (i.*)
@ i.pansharpen
- & SAGA
-I- Terrain Anahysis - Channels
& Channel network

2) Inthe dialogue select the dem fill for
the elevation and put the threshold at the
value you found in step 6 of the previous
section, e.g. 8. This means that streams
with a Strahler order larger than or equal
to this value will be considered as rivers.
The algorithm will calculate flow direction
and the Strahler order to determine the
channels and drainage basins.

Select the checkboxes for the following
outputs:
e Flow direction and save it as
flowdir.sdat
e Channels and save it as
channels.shp.
o Drainage basins and save it as
basins. shp (the other one is for
raster)

Always use the E] button and Save to
file... to browse to the right location (e.g.
D:\QGIS_Exercises\Exercise 5).
If the dialogue is similar as below, click Run.

@ Channel network and drainage basins

» Channel Netwerk and Drainage Basins

Parameters ] Log ]
Elevation
| B Filed DEM [EPSG:32532] = .|
Thresheld
/s =
Flow Direction
|D:,.'QGIS_Exercisestxerdse_S,’ﬁowdir.sdat J
[¥ Open output file after running algorithm
Flaw Connectivity
|[Sa'—.-'e to temparary file] J
[ Open output file after running algorithm
Strahler Order
|[Sa'—.-'e to temparary file] J
[ Open output file after running algorithm
Drainage Basins
|[Sa'—.-'e to temparary file] J
[ Open output file after running algorithm
Channels
|D:,.'QGIS_Exerdses,’Exerdse_S,‘ﬁannels.shp J
[¥ Open output file after running algorithm
Drainage Basins
|D:fQGIS_Exerdsestxerdse_S;‘basins.shp J
[¥ Open output file after running algorithm
Junctions
|[Sa'-.-'e to temporary filg] J
[~ Open output file after running algorithm

0% Cancel

Run as Batch Process... | Run | Close | Help |
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3) Inspect the results. Make legends for all these maps (are they discrete, continuous or
Boolean?).

e What does the Drainage Basins map show? Does it already give a good indication of
the Rur catchment?

e What does the Flow Direction map show? What does the legend mean? Make a nice
legend using styling.

e Does the stream delineation map (channels) reflect well the flowline of the Rur
river? Drag it to the top of the layers list and give it an intuitive style. Overlay the
Channels vector on OpenStreetMap to see if the derived streams fit with the rivers
on the map (make them different than blue to see the difference with the map.
What went well? What went wrong? Why?
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9.10 Define outflow point

A catchment is an extent or an area of land where surface water from rain, melting snow, or ice
converges to a single point at a lower elevation, usually the exit of the basin, where the waters join
another water body, such as a river, lake, reservoir, estuary, wetland, sea, or ocean. In order to
delineate a catchment we need to have two fundamental data:
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e the coordinates of our outlet in the same coordinate system as the map we are using

e the channel network that matches the flow directions as calculated from a hydrological
correct DEM

The outflow point of the Rur catchment is in Roermond an can be found in the given shapefile
source mouth.shp . The channel network that has been derived is in channels.shp.

1) Make sure you have the channels. shp layer on top of the OpenStreetMap layer from the
QuickMapServices plugin.

2) Check that the source mouth. shp (1) has the same projection as channels. shp, and
(2) that the outflow point is located exactly overlapping the delineated river in
channels. shp. If the outflow point is not exactly over the delineated river, the catchment
will not be delineated. In that case we need to look for a location over the delineated
channels as in this example:
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15
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Note that there has been some distortion for 3 reasons:
e Incorrect automatic delineation of streams, which can be caused by errors in the
DEM or areas that are too flat
e Distortion due to on-the-fly reprojection
o Human influence on the natural course of the channels

3) Now use the coordinate capture tool to get the coordinates of the outflowpoint in
channels. shp. You can find the coordinate capture tool from the menu: Vector >
Coordinate capture > Coordinate capture. Or look for this icon in the icon panel on the left
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of the screen: . Note that the plugin needs to be installed and activated (check the box
in the Plugins Manager). Another panel will show up:
Coordinate Captuns

Copy to dipboard

—:!-— Start capture

4) Click on Start capture and click on a point on the delineated river close to the mouth of the
Rur as indicated in the figure. Make sure you capture it from the river in channels. shp,
because the background map (OpenStreetMap) has not been derived from the DEM and will
result in errors in the catchment delineation. What projection are we using? How do you
know?

Coordinate Capture 8 X

©| [597702,51.19441

[ [288787.304,5675788.683

¥ Copy to clipboard |

—l Start capture |

9.11 Delineate catchment

Now we're going to use these coordinates to calculate the upstream area that produces discharge at
this point.

1) Inthe Processing Toolbox search for Upslope Area and choose SAGA - Terrain
Analysis - Hydrology = Upslope Area

Processing Toolbox g X
*‘.ﬁv ﬂv "'._; =

| L upslope

- & SAGA

—|- Terrain Analysis - Hydrology
& Upslope area
—I- Terrain Analysis - Morphometry
& Upslope and downslope curvature

87



2) Fillin the dialogue as below. Use the coordinates that you captured near the outflow point.
For elevation use your filled DEM. Use the default D8 method. Name the output
Rur catchment.sdat. Click Run. Click Close after the algorithm is done.

™ Upslope Area

Parameters ] Log ]

Target Area [optional]

| =

Target X coordinate

|288786.396000 =
Target ¥ coordinate
|5675815.310000 =
Elevation

5" dem_fil [EPSG:32632] =

Sink Routes [optional]

| =

Method

|[0] Deterministic 8 -
Convergence

|1.100000 =
Upslope Area

|D:/QGIS_Exercises/Exercise_5/Rur_Catchment.sdat J

I+ Open output file after running algorithm

0% Cancel

Run as Batch Process... | Run Close | Help |

The result should look like the screenshot below.
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3) In order to overlay the catchment boundary with other data, it is better to convert it from

raster to vector (polygon). To convert the raster layer to vector, go to the menu and choose
Raster - Conversion - Polygonize (Raster to vector). Make sure you choose the right input
and call the output Rur catchment.shp. Click Run. Click Close to get back to the main

screen.

| Raster Database Web Processing Help

‘%= Raster Calculator... [ (1 (7o
Align Rasters... —£

i tt Georeferencer...
Analysis
Projections
Miscellaneous
Extraction

\ B8 Polygonize (Raster to Vector)...

vy v v v

Bochalt

-

N {
a‘f”"’g“"_A g “» Rasterize (Vector to Raster)...
d| 45 RGBtoPCT..
umimen Zorh
& X ‘\'tw 2, ¥, Transhte (Convert Format)...

4) Look at the result. Also check the
attribute table (Click right on
layer name and choose Open
attribute table). What value has
the inside of the catchment
polygon? What value has the
outside area?

5) Of course we are only interested
in the catchment area, so we
have to remove the outside
polygon. In the attribute table
toggle to editing mode by using

v Polygonize (Raster to Vector)

Parameters I Log ]

Input layer

& Rur_Catchment [EP5G:32632]
Band number

IBand 1 =
Name of the field to create

IDN

[ Use 8-connectedness

Vectorized
|D:/QGIS_Exercises,fExercise_S,’Rur_Catchment.shp J

Iv Open output file after running algorithm
GDAL/OGR console call
gdal_polygonize.bat 7:/QGIS_Exercises/Exercise_5/

Rur_Catchment.sdat D:/QGIS_Exercises/Exercise_5/
Rur_Catchment.shp -b 1 -f "ESRI Shapefile" None DN

0% Cancel

Run as Batch Pmcess...‘ Run Close ‘ Help ‘

this button: . Then select the record that you want to remove. The selection will be

highlighted in yellow on the map. Then click W to delete the selected feature and toggle off

the editing by clicking again and save the changes.
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Web Processing Help
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6) Now remove all unnecessary layers from the layers list so that we have only

Source mouth, Channels, Rur catchment, OSM Standardand Filled DEM
(in that order).
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7) We can clip the Channels vector layer to see only the streams that are inside the
catchment. Go to the menu and select Vector - Geoprocessing Tools = Clip. Sometimes

the topology of the catchment polygon has some problems. In that case you can try other
clip functions from the Processing Toolbox.



| Vector Raster Database Web Processing Help i
- Geometry Tools * i 1
Analysis Tools Y @ convex Hul_.
I F
Eatz Ma:elrgergent Tools ' &' Difference...
esearch Tool
w ¥ Dissolve.. 1
— - Coordinate Capture ) q
oy % Intersection... .
D 8rae ki I Symmetrical Difference. .
Mewuwin, b @ union... 3
CRrUTr
ll_ w7 o Flminate Salarted Palkianne

8) Fillin the dialogue as below to use the catchment la
channels shape file to the catchment extent. Call the o

ver as a "cookie cutter" to clip the
utput channels clip.shp. Click

Run to run the tool. Click Close to return the main screen.

Parameters | Log |

Input layer
[/ channels_dlip [EPSG:32632] -l .| 2l
I™ Selected features only

QOverlay layer
[ Rur_Catchment [EPSG:32632]  ~| ...| 2]
I™ Selected features only

Clipped
DGIS_Exercises,-’Exercise_S,fchannels_clip.shp _|

i Open output file after running algorithm

Clip —
This algorithm clips a vector

layer using the features of an
additional polygon layer. Only

the parts of the features in the
Input layer that fall within the
polygons of the Overlay layer

will be added to the resulting
layer.

The attributes of the features

are not modified, although
properties such as area or

length of the features will be |

Run as Batch Pmcess...l

0% Cancel |

Run Close | Help |

9) Remove Channels from the layers list and drag cha

nnels clip to the top of the list.

10) Give channels clip anintuitive colour and make the Rur catchment polygon
hollow (no fill colour) and give it a thick red border. You can do this by clicking right on the
layer name, selecting Properties... and go to the Symbology tab. You can also press <F7> to
open the styling dock and set the styling options for different layers from there.
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The result should be similar to this:
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11) At this point save your project. Choose from the main menu Project - Save as...

e 5-0GIS

Project Edit View Layer Settings Pl

New CErl+N
New from Template 4

" QOpen... Ctrl+0
Open From 4
Open Recent 4

Close

Save Ctrl+5

gl @

Save As... Ctrl+Shift+5
Save To L4
Revert...

Properties... Ctrl+Shift+P
Snapping Options...
Import/Export 4

Q MNew Print Layout... Chrl+P
_wj Mew Report...
[4 Layout Manager...
Layouts »

Exit QGIS Ctr+Q
12) In the dialogue that follows, browse to D: \QGIS Exercises\Exercise 5 andsave
your project as Exercise 5.9gz
13) Now try to calculate slope, aspect and hillshade using the functions in the menu
Raster > Analysis or the processing toolbox and make some nice maps with good legends.

This whole exercise can be viewed in a screencast
at: https://youtu.be/Ro-RRzMMw-c
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Exercise 6: Using Open Data
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10 Using Open Access data

10.1 Introduction
Now that we have defined the boundaries of our study area, i.e. the Rur catchment, we can look for
open access data that is available on the internet. In this exercise we will use

e Data from the European Environment Agency (EEA) public map services:
http://discomap.eea.europa.eu

e Data from OpenStreetMap: http://www.openstreetmap.org

Instead of using a web browser, we will create a live link between the online data and our data in
QGIS, using Web Map Services (WMS), which is an open standard for sharing maps through the
internet and we will also download vector layers from OpenStreetMap through QGIS.

For this exercise you need the delineation of the Rur catchment and its streams from the previous
exercise. You can also download them from the Open Courseware website (http://ocw.unesco-

ihe.org).

Before we start, make sure that you have the following layers on your screen:

e Boundary of the Rur catchment
e Streams in the Rur catchment
e OSM Standard backdrop from the QuickMapServices

Your screen looks now like this:
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10.2 Adding data from the European Environment Agency (EEA) public map

services

The European Environment Agency (EEA) is the agency of the European Union (EU) that provides
independent information on the environment, thereby helping those involved in developing,

adopting, implementing and evaluating environmental policy, as well as informing the general public.

The European Environment Agency provides maps on thematic areas such as air, water, climate

change, biodiversity, land and noise

. The map services are accessible through

http://discomap.eea.europa.eu. In this exercise we will add data from the EEA public map services to

our QGIS project.

1) Go to the website http://discomap.eea.europa.eu. There you see a list of themes.

2) Click on Land under Land. Here you can see the EEA datasets related to land cover and their

descriptions.

3) Look for the CLC2012 ETRS89 LAEA (MapServer) data and click on More info to see what data

it contains.

4) Click on the picture of the map on the left to open an interactive map viewer
5) Inthe map viewer click on the Legend tab and zoom in at the study area.

[ ] | wwwarcgis.com/home
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6) Now we're going to add this land-cover data to our QGIS project. Go to your QGIS project.

From the main menu choos

e click the Open Data Source Manager button ‘!

7) Inthe Data Source Manager dialogue choose WMS/WMTS
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«! Data Source Manager | WMS5/

i‘ Browser
i i Vector
Raster
Mesh
Delmited Text
GeoPackage
" Spatialite

PostgreSQL

Oracle
DB2

m Virtual Layer

. WFS

=~

uf:g ArcGIS Map Server

rcGIS Feature Server

» GeoNode

Layers | Layer Order | Tilesets | Server Search |

=N e ~
annectl New | Edit | Removel Load | Save | AddDefaultSer\rersl

1D | Name | Title

| Abstract

—Image Encoding

— Options

Tie size |

Request step size |

Feature limit for GetFeatureInfo |ID
WES 84 Change...
[™ Use contextual WMS Legend
Layer name |
Ready
Close Add Help

8) In the dialogue that opens click the New button.

9) Inthe dialogue that follows type for Name: EEA Land

10) We can find the URL on the website: below the title of the CLC2012 ETRS89 LAEA

(MapServer). Click right on WMS and choose Copy link location
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Keywords

Copyright Text
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11) Paste the link in the QGIS dialogue (see screenshot below), keep the defaults and click OK.

= Create a New \ MTS Connection

—Ci ction details

Name |EEA Land

URL | http://land.discomap.eea.europa.eu/arcgis/services/Land/CLC2012_LAEA/MapServer/WMSServer?request=GetCapabilitiestservice=WMS

—Authentication
Configurations | Basic |

Choose or create an authentication configuration

INo authentication 'l _I _I EI

Configurations store encrypted credentials in the QGIS authentication database.

—~WMS/WMTS Options

Referer |

DPI-Mode [al |

™ Ignore GetMap/GetTile URI reported in capabilities
™ Ignore GetFeatureInfo URI reported in capabilities
™ Ignore axis orientation (WMS 1.3/WMTS)

I Invert axis orientation

™ Smooth pixmap transform

0K I Cancel | Help |

12) Back in the other dialogue window click Connect. The layers will now be retrieved from the
WMS server

13) Click on Wetlands so that it is highlighted, choose PNG for the Image encoding format (this
allows transparency) and check the box before Use contextual WMS legend. Then click Add
and Close to return to the main screen. Note that WMS layers are georeferenced pictures,

not vectors.

»! Data Source Manager | ¥ TS
W owser Lavers | Layer Order | Tiesets | Server Search |
Vector IEEA Land |
Raster Connect | New | Edit | Remove | Load Save Add Default Serversl
Mesh I Namel Title £ IAbstract |
® CLC12_ETRS89_LAFA Corine land Cover 2012

_ Agricultural Areas Corine Land Cover Agricuftural Areas include arable land, pe...

Delimited Text Artificial surfaces Corine Land Cover Agricuftural Areas include arable znd, pe...

Forest Semi Matural Areas Corine Land Cover Agricultural Areas include arable land, pe

GeoPackage Waterbodies Corine Land Cover Agricuftural Areas include arable land, pe...

- - Wetlnds Corine Land Cover Agricultural Areas include arable land, pe...

" Spatialite

PostgreSQL

—Image Encoding

@ png C PNGB  IPEG © GIF C TIFF  SVG

—Options (0 c linate ce systems

Tile size | |

Request step size | |

Feature limit for GetFeatureInfo |1[]
Change...

™ Use contextual WMS Legend

)-J ArcGIS Map Server

*

Layer name |
4 ATCGIS Feature Server Select layer(s)
Close Add Help

* GeoMode




e You can see that the source area of the Rur catchment is located in wetlands. What
are the names of these wetlands?
e In which country/countries are these wetlands?

14) Now add in a similar way Artificial Surfaces.

e In the midstream part of the catchment there are some large purple areas. What are
these?

e Add Google satellite from the QuickMapServices to have a closer look at these
features. Describe what you see.

e What are the other Artificial Surface classes in the map? Can you describe the
geographical distribution of population in the Rur catchment?

e  What are the largest cities in the catchment?

15) Load the remaining classes.
e Where are the forests and agricultural areas located?

16) Now rearrange the layers as such that you have a map with the catchment boundary, stream
network and land cover classes.
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17) Save the project before you continue.

If you have time, you can look for more EEA data in a similar way.
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10.3 Adding vector data from OpenStreetMap

OpenStreetMap (OSM) is a collaborative project to create a free editable map of the world. OSM is
considered a prominent example of volunteered geographic information (VGI) or crowdsourcing.
There are several ways to use the data:

e Through the interactive map on the OpenStreetMap website
(http://www.openstreetmap.org)

e In QGIS through the QuickMapServices Plugin

e In QGIS through the option to download OSM data directly from the internet. There are

several ways to do this. In this exercise we’ll use the QuickOSM plugin which uses the
Overpass API (https://wiki.openstreetmap.org/wiki/Overpass_API).

In this exercise we are going to download OSM vector data directly in QGIS for the Rur Catchment.
We continue from the previous results, but we only visualise the Rur Catchment and
Channels Clip layers. The other layers should be unchecked.

1) Install the QuickOSM plugin through the main menu: Plugins - Manage and Install
Plugins... Search for QuickOSM

2) Open the QuickOSM dialogue by choosing from the main menu: Vector 2 QuickOSM ->
QuickOSM

» FExercize_b - QGIS

Project Edit Wiew Layer Settings Plugins | Vector Raster Database Web Processing Help

D E_j E‘a’ {'j — Coordinate Capture lE_“‘u (O ( ]

3
A ]
1! @ Y ﬁ ﬁ W & Geoprocessing Tools F “¥ JOSM Remote
'f Geometry Toals L4
g 2 i

¢ A Analysis Tools L
Browser Data Management Tools * | % 1
ATHO Research Tools » ;

We’re first going to download the rivers so we can compare them with the rivers that we have

derived before. The OSM data attributes consist of keys and values. To learn more about it, click Help

with key/value.

3) Choose waterway as Key, river as Value. Choose the Rur catchment polygon as the
extent. Click the arrow before Advanced and make sure only Node, Way, Relation and Lines
are checked. The dialogue should now look like the screenshot below. Click Run Query.
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4)

5)

6)

7)

» QuickOSM

Quick
5 e ‘Help with kew’valuel Reset |
& oy Key | waterway -
' OSM File Value |river -l
> |Layer Extent j |'~---J Rur_Catchment j
¥ Advanced
Q About Node W Points r
Way Lines ¥
Relation ¥ Multilinestrings ™
Multipolygons
Timeout |25 =
Directory |Sa\-'e to temporary file _|
File prefix |

Show query Run query |

| 0%

Adjust the style and compare the waterway river from OSM with the

Channels Clip layer. What do you observe?

Let’s add the mines in a similar way. The key=1anduse, value=quarry. Don’t forget to
select Multipolygons instead of Lines.

Try to locate Jilich. You can also use the GeoCoding plugin to locate Jilich. You can install it
through the menu: Plugins = Manage and Install Plugins... . Search for GeoCoding. The
GeoCoding plugin uses web services (Nominatim and Google) to retrieve the coordinates of
an address.

Now zoom in on the centre of Jllich (see figure below).

7
NI

2 \ 74" a5y :
7 x A i B | "
Merzenhausen N i y 5 g
K6 Lo, e ! s i
& A Lich-Stainstrag. A X )
4 ;/ \j \ \ E )
28 < Y, 2, \
Koslar, Y 4 \
4 L4 v & Julich: ¥
Juich,l%éou n, Regi bezitk Koh{Nordrh
# mm,wlw/a )
v/ X !
Engelsdort {/3)}/
¢ Md@ﬁs& Konlgskamp & v
7 3 b4
/ 1253 /"\ 5
) ; p /
// o~ ¢ @ Nowrschutzgebiet
§ W | "tangenbroich Steterpither
GAM A ua [ N N wald {
T ™ NS Selgenblisch
= w**‘/‘. 1% o Bourheim '
en Kirchberg

Daubenrath

Schophoven

\ % krauthadsen

Braunkohle-Tdgebau
Irides

Oberzier

o
"7, Selhausty

fonhoven
Neu-Lohn

Huthem-Stammeln

i ¥

Brat




Southeast of Julich is the Forschungszentrum Jilich, a large research institute. In the south
and east we see a large surface mining of lignite. The one in the south is in the Rur
catchment.

8) Now compare the OSM derived quarry with a Google Satellite and the EEA artificial surfaces
map. What are the differences? Which one is more up-to-date? Google Satellite, EEA or
OSM? How does the hydrography relate to the quarry (OSM vs GIS delineated)?

9) Save the quarry polygons as a shapefile: click right on the layer, choose Save as...

In the dialogue, save the file as quarries. shp in the right folder using the Browse button.
Click OK to save the shapefile.
10) Now add a few other interesting features (points, lines and polygons), e.g.:
e Dams: Key=waterway, value=dam
e lakes: Key=natural, value=water
e Springs: Key=natural, value=spring
11) Style the layers with intuitive colours.
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11 Create 2D and 2.5D maps

11.1 Introduction
With the GIS data collected in the previous exercises, we are now ready to produce some maps to

take with us in the field. In this exercise we will produce two types of maps:

A PDF map with coordinate grid, north arrow, scale bar and legend (2D)

An interactive 2.5D map to visualise the layers draped over the DEM

You can make maps through combination of layers that we have collected in the previous exercises.

Project Edit Wiew Layer Settings Plugi

112 C
1)

3)

4)

reating a PDF map

First arrange the layers on the screen in such a way that all
layers you want to have in the map are visible and at the right
zoom level. Also verify that the on-the-fly projection is
EPSG:32632.

Configure the right styling of the layers. Remember to use
intuitive colours.

Use the Print Composer (Project - New Print Layout) to
create a map with all its properties (North arrow, scale bar,
intuitive legend, etc.). Use the instruction video on eCampus.

When finished choose from the menu Layout > Export as
PDF...

b

New
New from Template

Ctrl+N

Open...
Open From
Open Recent

Ctrl+0

Close

Save
Save As...
Save Ta
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@

Ctrl+S

Ctri+Shift+5
»

Properties...
Snapping Options...
Import/Export

Ctrl+Shift+P

8| New Print Layout...

2} New Report._.
.
|+ Layout Manager...
Layouts

Ctrl+P

4

Exit QGIS
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11.3 Creating a 2.5D interactive map
We can drape GIS layers over a DEM and create a 2.5D interactive map.

1) Open a new 3D map view by choosing from the main menu: View - New 3D Map View

Project Edit | View Layer Settings Plugins Vector Raster Databa:
JJ D [ -\ New Map View Chrl+M
—— MNew 3D Map View Ctrl+Shift+M

“ﬂ%(‘fj Pan Map

JJ JJ -x &» pan Map to Selection
.
& Zoom1In Ctri+Alt++

Browser
4= Zoom Out Ctri+Al+
A<

2) Inthe new 3D Map View (3D Map 1) click the configuration button -~

3) Inthe 3D Configuration dialogue choose the Filled DEM as Elevation and choose 10 for
the Vertical scale (the area is quite flat so we exaggerate 10 times). Keep the rest as default

and click OK.

21 3D Configuration

Terrain

Elevation [ dem_fill
Vertical scale [10.00 a
Tile resolution [16 px

Skirt height ~ [10.0 map units

L) ] 1] 1]

Map tile resolution |5 12 px

Max. screen error |3.[) px

Max. ground error |1.0 map units
Zoom levels 0-10

I” Show labels

™ Show map tile info

L) ] L

™ Show bounding boxes

I™ Show camera's view center

4) Enlarge the window. Use the scroll button of your mouse to zoom in/out. Drag the with the
scroll button clicked to create an oblique view. Navigate through the landscape with the
mouse or the arrow buttons. With the shift button pressed you can rotate around a point.

With the 2 button you can save the result to a TIFF file to include the 2.5D map in a report.
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11.4 Export to Google Earth

1) You can also export files to Google Earth. To export the catchment delineation to Google

Earth do the following: click right on the Rur catchment layer and select Export - Save

features as...

2) Inthe dialogue select Keyhole Markup Language [KML] as the output format. Choose an
output filename and click OK. The resulting file can be opened in Google Earth by double

clicking on the filename in Windows Explorer.

e Ve

Vector Layer as...

Format |Keyh0le Markup Language [KML]

File name |DJ;‘\QGIS_Exerclses\ExercLse_S\Rur_Gtchment.krT a |

=l

Layer name | Rur_catchment

CRS |EPSG:32632 - WGS 84 / UTM zone 32N =l 2
Encoding JutFe -] =
I™ save only selected features
¥ Add saved file to map
P Select fields to export and their export options
Symbology export |N0 symbology ;I
Scale [t:1000000 =1 &
¥ Geometry
Geometry type |Aut0matic j
™ Force multi-type
™ Include z-dimension
» [ Extent (current: layer) —
¥ Datasource Options
AlttudeMode  |relativeToGround |
DOCUMENT_ID [roct_doc ~|
oK I Cancel | Help |

Note that the CRS does not matter. A KML file will always be saved in the projection that is

supported by Google Earth.

® GoogleEathPro
Ble Edit Yiew Jools Add Help
¥ Search

Get Direcions History
¥ Places
- TS My Places

» ¢ B Sightseeing Jour

™ ¢ & Temporary Places.

S Fu_catchmentiml

| & ] s+ v

¥ Layers

™ @5 primaty Database

» ¢ P Borders and Labels
’ Places

yE

@ Ocean

»
’
»
» Ligr Gabery
»
»

£
Google Earth
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Exercise 7: Map design
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12 Styling and map design

12.1 Introduction
After this exercise you will be able to:

e Create a GeoPackage with data and styles
e Style vector layers

e Copy, import and export styles

e Designamap

In this exercise we are going to add mainly vector data related to water supply. The exercise encloses
the styling of various vector layers and designing of a map with various map item in the print
composer.

In this exercise we'll use the following data:

e Area.shp (and associated files): polygon of the area of interest
e FEndcap.shp (and associated files): points of the endcaps

e Household connection.shp (and associated files): points of house hold
connections

e Hydrants.shp (and associated files): pointsof the hydrants

e Pipeline.shp (and associated files):lines of the pipelines for the water
supply

e Source.shp (and associated files): points of the sources of water

e Tanks.shp (and associated files): points of storage tanks for water

The dataset has been developed by Vitens Evides International and the National Water and Sewerage
Corporation in Uganda.

You can download the data for Exercise 7 from the OpenCourseWare website
(http://ocw.unesco-ihe.org/course/view.php?id=11) and store the files in a folder on your harddrive
(e.8. D:\QGIS Exercises\Exercise 7).
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This exercise will guide you through the following steps:

Load shapefiles

Package
shapefiles into
GeoPackage

Load
GeoPackage
layers

Style layers

Save styles to
GeoPackage

Map design

12.2 Creating a Favorite in the Browser Panel

1.
2.

3.

Start QGIS Desktop.

Add the folder with the data from this exercise to the Favorites in the Browser Panel: click
right on Favorites and choose Add a directory.... Then browse to the Exercise 7 folder.
The contents of the folder will now be listed under Favorites for easy access.

Browser

« *Exercise_6 - QGIS

Praject Edit View Layer Settings Q: STrHO
= Y [ = v Favorites B

” D — =" = 75 Z:\QGI5_Exercises\Exercise_7

”ﬂ @ VE.:; ﬁj ﬁ; ” !ﬁ. (2 Area.shp

-2 Endcap.shp
| & %

-5 Household_connection.shp
Browser

-9 Hydrants.shp
-2 pipeline.shp
(2 source.shp

(2 Tanks.shp

- [¢r] Home
H- [ Cy
H- [ D2y
4
4

H- [ B\
t 05 20\
- € GeoPackage

ﬁ Spatialite -

First we check the metadata. Click right on Area. shp and choose Properties.... What is the
projection of this layer? Also check the projection of the other layers in the same way.
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! Layer Properties

Information from provider

Name
Path
Storage
Comment
Encoding
Geometry
CRS
Extent

Unit
Feature count

Areashp

ZYWIGIS Exercises\Exercise 7M\Area shp
ESRI Shapefile

UTF-2

Polygon (MultiPolygon)

EP5G:21096 - Arc 1960/ UTM zone 36N - Projected

362862.1131753329536878,369859.5358004590962082

368024.2126909086364321,375025.7825009398511611
meters
1

Close

|

24

4. Now select all the layers from this exercise with the shift button pressed and drag them to

the Map Canvas.

12.3 Creating a GeoPackage

Before we start styling these layers we are going to save them all into a GeoPackage, so we have all

the layers together in one file. Later we are also going to add the styles to the GeoPackage.

5. Inthe Processing Toolbox search for the Package layers tool

6. Double click on Package layers to open the Package Layers dialogue.

7. At Input layers click E] and select all vector layers

Processing Toolbox g X
SRS
1. package a

= () Database
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8. Choose Adjumani . gpkg as the Destination GeoPackage.

10.

11.

12.

13.

14.

Parameters l Log ]

Input layers

|7 elements selected

[ Overwrite existing GeoPackage

Destination GeoPackage
|D:,"QGIS_E:-:erclses,fExercise_?,fAdjun'nani.gpkg

» Multiple selection

Package layers

This algorithm collects a number of existing
layers and packages themn together into a
single GeoPackage database.

] Household_connection [EPSIG:21096]
Hydrants [EP5G:21096]

Pipeline [EP5G:21096]

] Source [EPSG:21096]

[¥] Tanks [EPSG:21096]

[ Endcap [EPSG:21086] E Select All
Clear Selection
Toggle Selection
Add File(s)...
Cancel

Run as Batch Process...

Click Run.

Now all the shapefiles have been stored in a
GeoPackage you can remove all the shapefiles
from the Layers Panel (right click > Remove
layer...).

To add the new GeoPackage layers first refresh

your Browser panel by clicking (& .

Click the plus sign before Adjumani . gpkg to

see the layers in the GeoPackage.

Select all these layers and drag them to the Map

Canvas.

Rearrange the layers so all data is visible.

0% Cancel

Run Close | Help |
Browser & X
QRETHO
= Favorites =)
= Z:\QGIS_Exercises\Exercise_7
=- B Adjumani.gpka
9 Area
o7 Endcap
2" Household_connection
2" Hydrants
4/ Pipeline
o Source
2" Tanks
~ Area.shp
~) Endcap.shp
9 Household_connection.shp —
(<) Hydrants.shp
4 Pipeline.shp
2 Source.shp
(9 Tanks.shp
+ Home
+ ()
+ D:\
T :

22 -
Layers 5 X
o [ & T [ W S

[[liarea

@ Endcap

©® Household_connection
© Hydrants

— Pipeline

® Source

@ Tanks
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12.4 Styling the vector layers

15. As a background, a satellite image can be used from the QuickMapServices Plugin. In the
menu choose Web - QuickMapServices > Google > Google Satellite.

16. Place the vector layers and the Google Satellite image in a useful order by dragging the items
in the layers list. For example, background images are normally the lowest layers.

We now start with styling the vector layers. Each layer is appointed a random style when you
open it. Styling covers the colours, shapes, sizes, text labels. The styling is done under the
properties of each layer (right-click on layer) or by using the Layer Styling panel by pressing
<F7>.

17. Now choose Household_connection - Properties - Symbology.

18. For the household connections a red cross will be the symbol to use. In order to do so select
simple marker = cross symbol. The Stroke colour should be red.

19. You can enter for the size 20 map unit and for the Stroke width 3.0 map unit. You can choose
between mm and map units. For millimetres the zooming level does not matter and the
symbol always stays the same size, even if you zoom in very closely. When selecting map
units, the symbol becomes bigger when you zoom in.

» Layer Properties - Household_connection | Symbology
= Single symbol jL
rf Information E‘x Marker
‘:{:\\ Source
# Symbology
€ labels
Diagrams
Ng 3D View
. : ot | Sl L_-!l isl Vl
E Source Fields
E Attributes Form Symbol layer type|Simple marker |
Toins Size |20.000000 = [Map Units 1% €
ﬁ Auxilary Storage Fill color |v‘ @'
{3_(9 Actions Stroke color MRE!
Display
- =550 Stroke style | Sold Line j @
V.
& Rendering - N —
A Stroke width |3.000000 @ = [Map Units s €
Variables
Join style Ia Bevel j @
a Metadata
Rotaton  [0.00° H€E
ﬁ Dependencies
X ID.DDDDDD j
Legend Offset IMiIIimeter 'I @
¥ ID.DDDDDD i’
QGIS Server
|vCenter | @ |
n Digitizin
T Style 'l 0K I Cancel | Apply | Help |

20. Click OK to close the dialogue and return to the map canvas.
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21. Open the attribute table of the Pipeline layer. Do this by clicking right on the layer and
choosing Open Attribute Table. Investigate the type of information that is there.

Layers 5 X

< m e, T 8.:'11'1
©  Adjumani Household_connection
Adjumani Endcap
Adjumani Hydrants
Adjumani Pipqjise .
© Adjumani Sou ) Zoom to Layer
® Adjumani Tan . Zoom to Selection
D Adjumani Are: T2 Show in Overview
= 7] B Google Satelli

Show Feature Count
Copy Layer

Rename Layer

L] Duplicate Layer
[1 Remove Layer...

Move to Top

5| Open Attribute Table

¢ Teggle Editing
Eilter...

Set Layer Scale Visibility...

Set CRS 4
Export 4
Styles 4
Properties..,

22. Now style the Pipeline vector layer by opening its properties. Instead of a Single Symbol,
select the Categorized. In the map, there needs to be a distinction between the transmission
lines and the distribution lines. In order to do so, which column do we need to select to

categorize on?

» Layer Properties - Adjumani Pipeline | Symbology

|—E Categorized

3 _ Mo symbols
Inforrmation = Single symbol

s, Categorized

Q Source = Graduated

= Rule-based

23. After the selection of the correct column, click Classify. You will find two new symbols for
‘Transmission’ and ‘Distribution’. By double clicking on the lines you can modify the style.

24. Choose an appropriate style according to your own insight. Just to remind you — use the map
unit for the width of the line. After finishing the styling of the two layers, click Apply.

25. The map should also indicate the type of material and the width of the pipeline by not using
anymore colours. For that we use text label, which you can also find in the Layer Properties
tab on the left side. Choose from the dropdown menu Single labels. Now you can select a
column using the drop down list at Label with.

26. If you want multiple columns in the label, you can enter an expression, which is next to the

arrow. Click the € | button to enter the following expression:
"Material o" || ' = ' || "Diameter o" [ " mm'

> The text between double quotation marks (") indicate the column.
The text between single apostrophe (') is a text of string.

» The double vertical bars (| |) are necessary to have multiple strings next to each
other.

> If the preview looks okay, click OK.
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Expression I Function Editor |

T R R e e

- symbol_color R R i
"Material 0" || '~ ' || "Diameter  value Contains functions which

" ' ' Aggregates aggregate values over layers
oal|Tm, Arrays and fields.
Color
Conditionals
Conversions
Date and Time
Fields and Values
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math
Operators
Record and Attributes
String
Variables
Recent (generic)

ESRETNe RE e

Output preview: 'HDPE - 20 mm'

oK I Cancel | Help |

27. The default text is not yet appropriate. To change this you find a lot of options below the
‘Lorem lpsum’, which shows an example of how the text will look.
> Under TEXT - For font use Tahoma, for size use 10 points, for colour choose blue.
Under Buffer - For Size use 1 mm
Under Placement — Choose curved, for position tick ‘On line” and untick ‘Above line’
Press OK

Y V V

2 Layer Properties - Adjumani Pipeline | Labels

@i Single labels

rt Information Label with I"Materlal o"||"-" || "Diameter 0" || *mm'

33 souce v Text Sample

Lorem Ipsum 2' 111544 ~] EI
abe Text Placement

2% Formatting

@be Buffer

E Source Fields @ Background © parallel * curved ¢ Horizontal

- Shadow
B8 Atbutes Form Py
#,% Placement

R

= &l

Lorem Ipsum i’
|

B

Allowed positions I~ Above ne ¥ On line [~ Below line

Joins  Renderng ™ Line orientation dependent position
Y Awizry storag pistance [0,0000 J1&
g Actions IMiIIimEtEr -1 &
- Display Repeat |No repeat :I @
& Rendering [Milimeter =2

Maximum angle between curved characters

Variables

=~ Metadata inside [25,0 = outside [25,0 &

ﬁ Dependencies ¥ Data defined

Legend Coordinate X = ¥

Alignment horzontal 4= vertical 4=

Rotaton €= ¥ Preserve data rotation values =

‘v Priority ‘ LI

Style - oK I Cancel | Apply | Help |

For the Source and the Tanks layers, the following two symbols will be created:
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These are basically two simple markers. Here the marker for the Source layer will be discussed.

28. Open Properties... = Symbology and Add a symbol layer 57 . Both simple markers should
be a circle. For the top circle:
e Make Stroke color transparent
e Set Fill color to red
e Set size to 20 map units

For the lower circle:

e Make Stroke color transparent
e Set colour to white
e Set size to 30 map units

» Layer Properties - Source | Symbology

= Single symbol j;
'ri Information = [l Marker
. Simple marker
‘:{s} Source . Simple marker |
Labels |
Diagrams
3D View
Source &| =| a|] of a] ¥
Source Fields
e Symbol layer typel Simple marker Ll
Size |30.000000 = [Map units s €
Fill color H @
Actions Stroke color H @
Display
Spay Stroke style | Solid Line ;l @'
Rendering - —
Stroke width IHairIine :I |Millimeter 'I @'
Variables
Join style |a Bevel j @
Metadata
Rotaton 0.0 ° H €
Dependencies
x |0.000000 =
Legend Offset - IMiIIimeter 'I @
y |0.000000 =
E Server
|vcenter =l @ |

H[Jig'rtizing Style 'l oK | Cancel | Apply | Help |
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29. Make a similar symbol for the Tanks layer as shown before step 25. We can easily do this by
copying the style and modifying it. To copy the style of Source click right on the layer name
and select Styles > Copy Style - All Style Categories.

Layers 8 x 00 °
.@ e T &~ it ﬂ o o
o Adi T h "
Adjumani Endcap a %\c
Adjumani Hydrants 63
" Adjumani P’ line o o
] ipeli b o 2
® [0 Zoom to Layer % 2
e Zoom to Selection
B Google Sat 7F Show in Overview o o\
Show Feature Count e q
Copy Layer
L] Duplicate Layer Add...
[ Remove Layer... Rename Current...
e v default
~ Open Attribute Table
/ Toggle Editing
Filter...
Set Layer Scale V\s\b\l\ty
Set CRS
Export ‘
Propemes
EEEEEEEEN
BRI EE EE
Q Type to locate (Ctrl+K) 8 legend entries  Edit Symbol...

30. Now click right on the Tanks layer name and select Styles > Paste Style > All Style
Categories.

31. You can now modify the style of the Tanks layer in the Styles dialogue similar to step 25.

32. Design your own symbol for the Endcap layer with a label to identify the ID.

33. The background satellite image is too dominant. We can make it transparent. Click right on
Google Satellite and choose Properties.... Set the Global opacity to 60%.

»| Layer Properties - Google Satellite | QGIS Server | Transparency ?

w Global opacity

[40,0 % =]

£

Information

ST ¥ HNo data value

_. I™ No data value not defined
" Symbaology

Additional no data value |

L'f Transparency

¥ Custom transparency options

Q_"I Rendering Transparency band |Nc|ne ;l

. Transparent pixel list
! Metadata
From | To Percent Transparent | 2

Legend

E QGIS Server

= 5 |5 [o [ &

Style 'l oK I Cancel Apply | Help |
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34. Lastly the style of the Area polygon layer will be set. Open Properties... = Symbology tab
—> add symbol layer (the + sign). For the top symbol layer choose the following specifics:
e Fillis transparent
e Stroke color is grey
e Stroke widthis 2 mm
For the bottom symbol layer choose the following specifics:
e Symbol layer type is Shapeburst fill
e Change the gradient colours to grey and white with 50% opacity
e Shade to set a distance to 5mm.

35. Lastly change from ‘Single Symbol’ to ‘Inverted polygons’. This actually means that you are
styling everything outside the selected polygon and click OK

»! Layer Properties - Adjumani Area | Symbology

Inverted polygons

f» e =
g Information S e |_= Single symbal j

‘:{:\} Source ™ Merge polygons before rendering (slow)

= Al
& symbology - [ simple il
Shapeburst fil
€& labels
v

N | - 2|4

o,

W
E Source Fields L |M|II|meter
Dpacity J|100,0 % =

E Attributes Form Color

The result now looks like this:

o
Lo

B3 36537640
a2 i o ¥ & E2

£

HOPE 63 men, 74 s ¥ 9 iy o £ 1 2
Bl NG i e

12.5 Saving layer styles
Layer styles are not stored in the GIS files (e.g. shapefile or GeoTiff). They can be stored in your

project file (a . ggz file), together with the zoom level, on-the-fly projection, etc.
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36. Save the project as Adjumani . ggz. In the menu choose: Project > Save as... and save the

file to the correct folder.

If you don’t want to share an entire QGIS project,
but just a layer with its styling, you’ll have to save
the styling to a file. Similar to an ArcGIS Layer file
(. 1yr) QGIS has its own format, the Layer
Definition File (. glr). Please note that these are
software specific xml files and not international
standards that allow for interoperability among
software. For interoperability, it is better to use
the Styled Layer Descriptor (SLD) file. SLD’s are
also used to style online maps.

37. To save the style go back to the
Symbology dialogue and select Style >
Save Style...

38. In the Save Layer Style dialogue you can
choose one of the formats. Let’s first save

» Save Layer Style

Save style |As QGIS QML style file -
File As QGIS QML style file

In database (GeoPackage)
< Symbology
@ 3D Symbology
# Labels
~ Fields
Forms
8 Actions
Map Tips
W, Diagrams
| Attribute Table Settings
¥ Rendering
“%, Custom Properties
* Geometry Options

Categories

NENEHRREEEREF

oK | Cancel Help

it as an SLD file.

ction | Symbology

ngle symbol

G’ Information X x Marker
“ ¢ simple marker
“"{S} Source

Q’ Symbology

€ Labels

Diagrams

>
L}
\" 3D View

Source Fields iI—I—ILliliI

E Attributes Form Unit  |Milimeter

Joins Color

§ Auxiia ry Storage Size |20.00000

@ RETETE Rotation |0.00 ®

@ Dispiay

=

Opacity |[to00% =
-

HE

HE

| & Al symbols a - &

7
4 Ren dering |

Variables

Load Style...
B vens

ﬁ Dependencies Save as Defauft
Restore Default

*

diamond green
Legend Add.

Rename Current...

« default
L@ Digitizing

]
L 4 °

diamond red dot black

|

Save Symboll Advanced 'l

0K Cancel Apply | Help |
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If you would now start a new project and you add a layer, you can also load a saved style from
the . s1d file. Also if you would upload a shapefile to GeoServer, you can use the . s1d file to
style the online map.

A great advantage of a GeoPackage is that also styles can be saved in the GeoPackage, so we
really keep everything together in one file that we can easily share with others.

39. Go back to the Symbology dialogue and select Style > Save Style...

40. Now choose In database (GeoPackage)

41. In the Save Style in Database dialogue give for the Style Name the name of the layer and
provide a Description. Check the box to Use as default style for this layer and click OK.

=) Save Layer Style ?

Save style |[n database (GeoPackage) j
Style name [Household

Style of household connection|
Description

ul [ [l

W Use as default style for this layer

OK Cancel | Help |

42. Repeat this for all vector layers

43. Check if this indeed works: close QGIS, reopen and load the layers from the GeoPackage
again. Don’t forget to also add the Google satellite, make it 60% global opacity and reorder
the layers. The styles of the vector layers should be as you defined them before.

This exercise can be viewed in a screencast at:
https.//youtu.be/i95xHt51eql
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12.6 Make a map in the print composer

1. Create under Project - New Print Layout a new layout and give it an appropriate name, e.g.
Adjumani.
! *adjumani - QGIS
Project Edit Wiew Layer Settings Pl
| MNew Ctrl+M
Mew from Template 4
Open__. Ctrl+0
Open From 3
Open Recent 3
Close
[ save Ctri+s
) save As... Crl+Shift+5
Save To L
Rewert...
Properties... Ctrl+Shift+p
Snapping Options...
Import/Expart » » Create print layout Title
B New Print Layout... Ctrl+P Enter 3 unigue print lyout title
i\ New Report... (a title will be automatically generated if left empty)
¢ Layout Manager... |Adjumani
Layouts 4
oK | Cancel
Exit QGIS Ctr+Q

2. Normally, you need to design a map layout before you start to make the map, this means
that you already know the general set up of the map and the various items you want to show
on the map.

Title Title Title
reference reference map
map 1
MAIN MAP MAIN MAP reference e MAIN
L}’l reference map MAP
legend —
g |
]

3. To set up the print layout, you need to choose which paper size you want to use (A3/A4 etc.).
Click right on the paper and choose Page Properties.... The export DPI (dots per inch) is
important for the quality of the map. With more dots per inch, you will get a higher quality
(and larger size) export product. A DPI of 300 is appropriate for now. You can also choose
between ‘Landscape’ vs ‘Portrait’ according to your needs. Here we’ll make an A3 landscape
map.

4. Click the Add a map button |EJ and click and drag to insert the map.
Under Item properties, you can edit the position on the canvas and zoom in. Find an area of
. - %
interest to you. You can also use the Move item content button .

5. Asyou are now zoomed in to a part of the city in the map, a small overview map makes it

easier to orientate yourself. Again click the Add a map button and drag a smaller map. (If you
hold shift, it will become perfectly rectangular). Zoom out until you have the whole area in
the overview map.
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http://docs.qgis.org/2.0/en/_images/mActionAddMap.png

6. To create an overview select the tab Item properties. Under Overviews click the + sign to add

2 *Adjumani

an overview. Select for Map Frame Map 1. You can edit the color, transparency and even
make it inverse. Choose yourself.

Layout Edit View Items Add Item Atlas Settings

= = = o e VPR NN N
BERLREBR koo Bk ¢F 1dHeusl
P @ 6 T3~ i | | hhb H
AN 5. B, 00, Bl
[ | ..;.".ll?o.ul.."lw.o..m.l...P.so...‘.‘.lsgo‘.‘l.‘ulss.o‘“1..“140‘0.‘»‘4..‘ ttems | Undo History
@ 5 Items & x
19| 3 ® [@ [tem
2| 1 0O ) Map2
3 = 0O BEMapl
5
ol
oo
=
Tﬂ _‘ Layout  Item Properties ] Guidesl
= 3 Item Properties & X
g -
3- Map 2
iEs =
2| 3 » [T Controlled by atlas
S -
a| 2 » Grids
7a| - 2
I\ = ¥ Overviews
(8-
iR
Lk & | = A v
=8| 2 =
= Overview 1
=2 -
FE
e
3 v [V Draw "Overview 1" overview
3 Map frame M Map 1 v
= Frame style M
e Blending mode [Normal - —
3 ™ Invert overview
I™ Center on overview
R
]2
3 » Position and size
3 » Rotation |
1 item selected X: 231 mm y: 0 mm page: 1 50.1% = _]‘—'

7.

10.

11.

Now you will see every layer in the overview map, but we can remove some detail to make it
easier to understand. Go back to the Map Canvas of QGIS and untick every layer except the

Area layer.

Go back to the Print Layout and Select the overview map. Under its Item Properties = Tick
Lock Layer for this Map. Click Update preview. Now it will only use the Area layer to draw

the map and it will be fixed if you tick the layers back on for the larger detailed map.
Below you find an overview to add other items.

NOTE: under properties you will find many options per item. The default is often not the one

you want.

=]
Do not forget to save the project file (.QGZ) once in a while.

| == ] = T
Now add north arrows q logos q scale bars Ed legends Lo (sub)titles . to your

choosing. Be creative!

12. After finishing the map with your satisfaction, export the map to a pdf I% or an image @

=S

> é}:!'l' é;:E'

5l
R

b

Export to an image format, to PDF or to SVG
Zoom to full extent, in and out
Refresh view

Revert and restore last change
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http://docs.qgis.org/2.0/en/_images/mActionFileSave.png
http://docs.qgis.org/2.0/en/_images/mActionScaleBar.png
http://docs.qgis.org/2.0/en/_images/mActionAddLegend.png
http://docs.qgis.org/2.0/en/_images/mActionLabel.png
http://docs.qgis.org/2.0/en/_images/mActionSaveAsPDF.png
http://docs.qgis.org/2.0/en/_images/mActionSaveMapAsImage.png
http://docs.qgis.org/2.0/en/_images/mActionSaveMapAsImage.png
http://docs.qgis.org/2.0/en/_images/mActionSaveAsPDF.png
http://docs.qgis.org/2.0/en/_images/mActionSaveAsSVG.png
http://docs.qgis.org/2.0/en/_images/mActionZoomFullExtent.png
http://docs.qgis.org/2.0/en/_images/mActionZoomIn.png
http://docs.qgis.org/2.0/en/_images/mActionZoomOut.png
http://docs.qgis.org/2.0/en/_images/mActionDraw.png
http://docs.qgis.org/2.0/en/_images/mActionUndo.png
http://docs.qgis.org/2.0/en/_images/mActionRedo.png

Add new map from QGIS map canvas

Add image to print composition (images such as logo, north
arrow)

Add label to print composition (text such as (sub)titles or
abstract)

Add new legend to print composition
Add new scalebar to print composition
Add basic shape to print composition

Add arrow to print composition

Move content within an item (move within a map to redefine the

X, y and scale)

Group items of print composition and Ungroup
Raise/Lower selected items

Move selected items to top/bottom

Align selected items left / right center / center vertical / top /
bottom
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http://docs.qgis.org/2.0/en/_images/mActionRaiseItems.png
http://docs.qgis.org/2.0/en/_images/mActionLowerItems.png
http://docs.qgis.org/2.0/en/_images/mActionMoveItemsToTop.png
http://docs.qgis.org/2.0/en/_images/mActionMoveItemsToBottom.png
http://docs.qgis.org/2.0/en/_images/mActionAlignLeft.png
http://docs.qgis.org/2.0/en/_images/mActionAlignRight.png
http://docs.qgis.org/2.0/en/_images/mActionAlignHCenter.png
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Links

EPSG codes: http://www.spatialreference.org

European Environmental Agency Public Map Service: http://discomap.eea.europa.eu

OpenStreetMap: http://www.openstreetmap.org

QGIS: http://www.ggis.org/

SRTM data description: https://Ita.cr.usgs.gov/SRTM1Arc

USGS EarthExplorer: http://earthexplorer.usgs.gov

Screencasts
Screencasts can be found in the following YouTube channel:
http://www.youtube.com/c/HansvanderKwast

Please subscribe for updates.

121


http://www.spatialreference.org/
http://discomap.eea.europa.eu/
http://www.openstreetmap.org/
http://www.qgis.org/
https://lta.cr.usgs.gov/SRTM1Arc
http://earthexplorer.usgs.gov/

